ChemiDoc™ MP Imaging System with Image Lab™ Software
User Guide
Version 5.1
Notice

No part of this publication may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopy, recording, or any information storage or retrieval system, without permission in writing from Bio-Rad.

Bio-Rad reserves the right to modify its products and services at any time. This user guide is subject to change without notice. Although prepared to ensure accuracy, Bio-Rad assumes no liability for errors or omissions, or for any damage resulting from the application or use of this information.

Credits

1. Image Lab software is based in part on the work of the Qwt project (http://qwt.sf.net).

2. Image Lab software is based in part on the work of the CImg project (http://cimg.sourceforge.net/).
   See license for details at http://www.cecill.info/licences/Licence_CeCILL-C_V1-en.html

3. Image Lab software is based in part on the work of the Independent JPEG Group (http://www.ijg.org/)

GelStar is a trademark of FMC Corporation. IRDye is a trademark of LI-COR Biosciences. OliGreen, PicoGreen, and Pro-Q are trademarks of Invitrogen Corp. Alexa Fluor, Coomassie Fluor, Qdot, and SYPRO are trademarks of Invitrogen Corporation. Coomassie is a trademark of BASF Aktiengesellschaft. Cy2 and Cy3 are trademarks of GE HealthCare. DyLight and Krypton are trademarks of Thermo Fisher Scientific Inc. Excel, PowerPoint, and Windows are trademarks of Microsoft Corporation. FireWire, iWork, Mac, Mac OS, and Numbers are trademarks of Apple Inc. GelGreen and GelRed are trademarks of Biotium, Inc. Intel Core and Pentium are trademarks of Intel Corporation. Mitsubishi is a trademark of Mitsubishi Companies. PulseNet International is a trademark of Centers for Disease Control and Prevention. Slo-Blo is a trademark of Littelfuse, Inc.

SYBR is a trademark of Molecular Probes, Inc. Bio-Rad Laboratories, Inc. is licensed by Life Technologies, Inc. to sell reagents containing SYBR Green I for use in real-time PCR, for research purposes only.

CHEF (U.S. Patent Number 5,549,796, issued to Stanford University) is exclusively licensed to Bio-Rad Laboratories, Inc.

Precision Plus Protein standards are sold under license from Life Technologies Corporation, Carlsbad, CA, for use only by the buyer of the product. The buyer is not authorized to sell or resell this product or its components.

Bio-Rad Laboratories, Inc. is licensed by Invitrogen Corporation to sell SYPRO products for research use only under U.S. Patent Number 5,616,502.

Copyright ©2014 Bio-Rad Laboratories, Inc.
# Table of Contents

## Safety and Regulatory Compliance
- Important Safety Information .................................................. 11
- Warranty ................................................................................... 12
- General Precautions .................................................................... 12
- Regulatory Notices ....................................................................... 13
- Instrument Safety Warnings ......................................................... 13
  - Notice ..................................................................................... 14
- Power Safety Information .............................................................. 15
  - Voltage Setting Information ....................................................... 15
  - Fuses ...................................................................................... 15

## Chapter 1 Introduction
- ChemiDoc MP Imager ................................................................. 17
- System Components .................................................................... 18
  - CCD Camera and Lenses ............................................................. 18
  - Universal Hood III ................................................................... 19
- Image Lab Software ...................................................................... 19
- Emission Filters .......................................................................... 19
- Optional Accessories ................................................................... 20
  - Printer .................................................................................... 20
  - Conversion Screens ................................................................. 20
  - Optional Light Sources ............................................................ 20
- ChemiDoc MP Imager Applications ............................................ 21
- ChemiDoc MP Technical Specifications ...................................... 23
- ChemiDoc MP Imaging System Workflow ................................... 25
- For More Information ................................................................. 25
# Table of Contents

## Chapter 2  Setting Up the Instrument with Image Lab Software  

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Requirements</td>
<td>27</td>
</tr>
<tr>
<td>Image Lab Security Edition</td>
<td>27</td>
</tr>
<tr>
<td>Computer Specifications</td>
<td>27</td>
</tr>
<tr>
<td>Installing Image Lab Software</td>
<td>28</td>
</tr>
<tr>
<td>Installing the Drivers on a Windows XP Computer</td>
<td>34</td>
</tr>
<tr>
<td>Installing the Drivers on a Windows 7 Computer</td>
<td>37</td>
</tr>
<tr>
<td>Setting Up Image Lab Security Edition</td>
<td>37</td>
</tr>
<tr>
<td>Activating and Deactivating Security Edition</td>
<td>37</td>
</tr>
<tr>
<td>Enabling and Disabling Image Lab Secure Mode</td>
<td>44</td>
</tr>
<tr>
<td>Setting Security Preferences</td>
<td>48</td>
</tr>
<tr>
<td>Renaming Security Groups</td>
<td>51</td>
</tr>
<tr>
<td>Using Groups on a Local Domain</td>
<td>51</td>
</tr>
<tr>
<td>Changing Security Preferences</td>
<td>52</td>
</tr>
</tbody>
</table>

## Chapter 3  Image Lab Software Overview  

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface Overview</td>
<td>55</td>
</tr>
<tr>
<td>Main Window</td>
<td>55</td>
</tr>
<tr>
<td>Main Toolbar</td>
<td>56</td>
</tr>
<tr>
<td>Results Data</td>
<td>56</td>
</tr>
<tr>
<td>Display Toolbox</td>
<td>56</td>
</tr>
<tr>
<td>Start Page</td>
<td>57</td>
</tr>
<tr>
<td>Analysis Tool Box</td>
<td>57</td>
</tr>
<tr>
<td>Status Bar</td>
<td>59</td>
</tr>
<tr>
<td>Menu Commands</td>
<td>60</td>
</tr>
</tbody>
</table>

## Chapter 4  Acquiring Images  

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Protocol Setup Window</td>
<td>68</td>
</tr>
<tr>
<td>Single-Channel Protocols</td>
<td>68</td>
</tr>
<tr>
<td>Multichannel Protocols</td>
<td>70</td>
</tr>
<tr>
<td>Creating a Protocol</td>
<td>70</td>
</tr>
<tr>
<td>Setting Up a New Protocol</td>
<td>71</td>
</tr>
<tr>
<td>Step 1. Gel Imaging for Single-Channel Protocols</td>
<td>72</td>
</tr>
</tbody>
</table>
Table of Contents

Step 1. Gel Imaging for Multichannel Protocols ................................................. 74
Step 2. Detect Lanes and Bands. ................................................................. 79
Step 3. Analyze Molecular Weight. ............................................................... 82
Step 4. Specify Output .............................................................. 85
Review Protocol Settings .......................................................... 86
Creating a Multichannel Image from Single Images ........................................... 87
Editing a Saved Protocol .............................................................. 88
Positioning the Gel .............................................................. 90
Running a Protocol .............................................................. 91
Running Signal Accumulation Mode (SAM) Protocols ........................................ 92
Saving Signal Accumulation Mode (SAM) Images .............................................. 93
Setting Up a Custom Application ......................................................... 94
Regression Methods .............................................................. 96
Application Tables ................................................................. 97

Chapter 5 Viewing Images ................................................................. 101
Displaying Gel Images .............................................................. 102
  Display Gel Options .............................................................. 102
  Zoom Tools .............................................................. 103
  Fit in Window .............................................................. 104
  Image Transform .............................................................. 104
  Image Colors .............................................................. 107
  3-D Projection .............................................................. 108
  Image Info .............................................................. 109
Displaying Multichannel Images ................................................................. 110
  Multichannel View .............................................................. 111
  Splitting Multichannel Images ................................................................. 112
Displaying Data .............................................................. 116
  Analysis Table Options .............................................................. 116
  Lane and Band Table Measurement Definitions .............................................. 119
  Volume Measurement Definitions ................................................................. 119
  Lane Profile .............................................................. 121
  Standard Curve .............................................................. 124
  Report .............................................................. 125
# Table of Contents

**Chapter 6 Analyzing Images** .......................................................... 127

- Image Types .................................................................................. 127
- Using Auto Analysis. ..................................................................... 128
- Analysis Tool Box Tools ............................................................... 129
  - Image Tools ................................................................................ 130
    - Correcting a Slanted Gel ......................................................... 131
    - Cropping a Gel Image ............................................................ 131
    - Inverting Data ......................................................................... 132
    - Merging Images ................................................................. 132
- Lane and Bands Tools ................................................................... 133
  - Detecting Lanes ......................................................................... 134
  - Using the All Lanes and Single Lane Tools .............................. 134
  - Copying Lanes .......................................................................... 138
  - Detecting Bands ........................................................................ 138
  - Editing the Detected Bands ...................................................... 142
- Normalizing Volume Data ............................................................. 143
  - Using the Normalization Tool .................................................... 144
  - Optimizing Normalization of Volume Data .............................. 145
    - Detect the Lanes in the Channels .......................................... 146
    - Make Adjustments to the Lanes ............................................ 146
    - Detect the Bands ............................................................... 148
    - Subtract any Extraneous Background ................................. 149
    - Remove Compromised Data ............................................... 149
    - View the Data in the Analysis Table .................................... 150
    - Adding a Channel to a Single Image ..................................... 151
- Molecular Weight (MW) Analysis Tools ........................................ 154
- Quantity Tools ............................................................................. 160
- Annotation Tools ........................................................................ 166
  - Add Annotations ....................................................................... 167
  - Alignment ................................................................................ 167
  - Text Properties ......................................................................... 168
  - Color ....................................................................................... 168
  - Rotate ..................................................................................... 168
- Volume Tools ................................................................................ 169
# Table of Contents

## Chapter 7  Generating Reports ........................................... 175
- Report ............................................................................ 175
- Report Settings ............................................................ 176
- Print Report ................................................................. 179
- Print Report to a PDF File .............................................. 179
- Adjust the Printer Settings ............................................. 180

## Chapter 8  Exporting Results .............................................. 181
- Exporting Gel Images .................................................... 181
- Exporting Gel Images for Publication ............................. 182
- Exporting Gel Images for Analysis ................................. 184
- Exporting Gel Images to PulseNet International ............. 185
- Exporting Lane and Band Tables to Excel ..................... 185
- Exporting Volume Tables to File ................................... 185
- Screenshot Tool Export .................................................. 185
- Analysis Table Export ................................................... 186

## Chapter 9  System Calibration .............................................. 187
- Recalibrating Your Imager ............................................. 188

## Chapter 10  Image Lab Logs ................................................. 191
- Image Lab Logs ............................................................ 191
- Viewing the Instrument Log .......................................... 192
- Viewing the System Log ................................................ 193
- Viewing the Document Log ........................................... 194
- Displaying Log Data ..................................................... 195
- Displaying Data Columns in Logs ................................. 195
- Filtering Data in Logs .................................................... 196
- Collapsing or Expanding Data Rows .............................. 198
- Exporting Logs ............................................................. 199
- Printing Logs ............................................................... 200
# Table of Contents

## Chapter 11 Using the Security Edition .................................. 203
- 21 CFR Part 11 .......................................................... 203
- Standard Mode versus Secure Mode .................................. 204
- User Names, Groups, and Roles ....................................... 204
  - Role Restrictions .................................................. 206
- Starting Image Lab Security Edition .................................. 207
- Electronic Records .................................................... 207
  - Unsecured Documents ............................................ 208
  - Secure Documents ................................................ 208
  - Modifying Secure Documents .............................. 209
- Signing Documents .................................................. 210
- Document Logs ...................................................... 211
  - Viewing the Document Log .................................... 212

## Appendix A Maintenance .................................................. 213
- UV Transilluminator Lamp and Starter Replacement ............ 213
- Fuse Replacement .................................................... 215

## Appendix B Troubleshooting .............................................. 217

## Appendix C Setting Up Users and Groups ............................... 219
- Setting Up Image Lab Users and Groups .......................... 219
- User Accounts ....................................................... 219
- User Authentication and Group Membership ...................... 219
  - Finding the name of your authentication domain .......... 221
- Configuring Users and Groups on a Local Computer ......... 222
- Configuring Users and Groups on a Network Domain ......... 226
- Password Security .................................................. 230
  - Password Policy Setting Examples ............................ 232
- Account Lockout Policy Setting Examples ....................... 232
- Auditing Windows Event Logs ..................................... 232
- Miscellaneous Security Measures ................................. 233
# Table of Contents

## Appendix D Accessories
- Calibrating Accessories .............................................. 235
- Installing Optional Accessories .................................... 235
  - Epi Light Modules .................................................. 235
  - UV/White Light Conversion Screen ................................. 236
  - XcitaBlue™ Conversion Screen ..................................... 237
  - Gel Alignment Template Kit ......................................... 239
  - Orange Fluorescence Reference Plate ............................... 240
- Ordering Information .................................................... 243

## Appendix E Using Bio-Rad’s Stain-Free Technology ........ 247
- Stain-Free Workflow .................................................... 248
- Electrophoresis with Stain-Free Gels ................................. 249
- Imaging Gels ................................................................ 249
- Imaging Blots ................................................................ 250

## Appendix F Mitsubishi P93/P95 Thermal Printer .............. 251
- Setting up a Thermal Printer on Windows ......................... 251
- Setting up a Thermal Printer on a Mac ............................. 252

## Appendix G Regression Calculation Methods .................. 253

## Glossary ....................................................................... 255
Safety and Regulatory Compliance

Important Safety Information

Please read these instructions before attempting to operate the ChemiDoc MP™ imaging system.

This instrument is suitable for research use only. It must be used, therefore, only by specialized personnel who know the health risks associated with the reagents that are normally used with this instrument.

Use of the ChemiDoc MP imaging system involves UV illumination. Proper precautions must be taken to avoid eye and skin exposure to the UV radiation. This instrument is meant for use only by trained personnel who know the health risks associated with the UV radiation normally used with this instrument. The acrylic shield provides some UV protection. However, it does not guarantee complete protection, and it is designed to shield only the person working in front of the imager.

WARNING! Use of the acrylic screen does not guarantee the user protection from UV radiation. The use of protective eyeglasses, mask, and/or gloves is strongly recommended.
**Warranty**

The ChemiDoc MP imaging system is warranted against defects in materials and workmanship for one year. If any defect occurs in the instrument during this warranty period, Bio-Rad Laboratories, Inc. will repair or replace the defective parts at its discretion without charge. The following defects, however, are specifically excluded:

- Defects caused by improper operation
- Repair or modification done by anyone other than Bio-Rad Laboratories, Inc. or the company's authorized agent
- Use of spare parts supplied by anyone other than Bio-Rad Laboratories, Inc.
- Damage caused by accident or misuse
- Damage caused by disaster
- Corrosion caused by improper solvents or samples

**General Precautions**

- Read the user guide carefully.
- The instrument must be used only for the intended purpose of gel documentation in research laboratories.
- The instrument must be connected to a grounded power source line and protected by a circuit breaker.
- Do not pour liquids directly on or inside the instrument.
- Switch off all lights on the instrument immediately after use.
- Clean the transilluminator sample area after use.
Regulatory Notices

The ChemiDoc MP imaging system is designed and certified to meet EN 61010, the internationally accepted electrical safety standard, EMC regulations, and TUV requirements. Certified products are safe to use when operated in accordance with this user guide. Do not modify or alter this instrument in any way. Modification or alteration of this instrument will:

- Void the manufacturer’s warranty
- Void the regulatory certifications
- Create a potential safety hazard

**WARNING!** Bio-Rad Laboratories, Inc. is not responsible for any injury or damage caused by use of this instrument for purposes other than those for which it is intended or by modifications of the instrument not performed by Bio-Rad Laboratories, Inc., or an authorized agent.

Instrument Safety Warnings

Notes, cautions, and warnings are used to highlight certain operating procedures and recommendations. The table below describes how each is used in this document.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note:</td>
<td>Note: A note indicates a special procedure, an exception to normal operation, or something else of specific interest to the reader. Notes are preceded by the word <strong>Note</strong>.</td>
</tr>
<tr>
<td>Caution:</td>
<td>A caution precedes an operational step that could damage the instrument or destroy data unless the operator takes certain precautions. Cautions located in the main text are preceded by the word <strong>Caution</strong> and are accompanied by the caution symbol in the left margin.</td>
</tr>
</tbody>
</table>
Notice

The ChemiDoc MP imager is intended for laboratory use only. This device is meant for use by specialized personnel who know the health risks associated with reagents normally used in electrophoresis. The UV light source is computer controlled, and proper interlocks are implemented to avoid users’ accidental exposure to UV radiation. Bio-Rad Laboratories, Inc. is not responsible for any injury or damage caused by use of this instrument for purposes other than those for which it is intended, or for instrument modifications not performed by Bio-Rad Laboratories, Inc. or an authorized agent.

Table 1. Notes, Cautions, and Warnings, continued

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Caution:</strong> With the exception of cleaning or replacing light bulbs, refer all servicing to qualified Bio-Rad personnel or their agents. If you experience technical difficulties with the instrument, contact Bio-Rad to schedule service. The instrument should not be modified or altered in any way. Alteration voids the manufacturer's warranty and might create a potential safety hazard for the user.</td>
<td></td>
</tr>
<tr>
<td><strong>Caution:</strong> If the case interlock is defeated, there is a possibility of UV-B radiation hazard due to UV-B light exposure. Exercise caution when servicing the instrument.</td>
<td></td>
</tr>
<tr>
<td><strong>Caution:</strong> Bio-Rad is not responsible for any injury or damage caused by the use of this instrument for purposes other than that for which it is intended, or by the modification of this instrument when not performed by qualified Bio-Rad personnel or their agents.</td>
<td></td>
</tr>
<tr>
<td><strong>Caution:</strong> Disconnect the AC power cord before removing the instrument cover.</td>
<td></td>
</tr>
<tr>
<td><strong>Warning:</strong> A warning precedes an operating procedure that could cause injury to the operator if not followed correctly. Warnings located in the main text are preceded by the word <strong>Warning</strong> and are accompanied by the warning symbol in the left margin.</td>
<td></td>
</tr>
<tr>
<td><strong>Warning:</strong> This instrument must be connected to an appropriate AC voltage outlet that is properly grounded.</td>
<td></td>
</tr>
</tbody>
</table>
Power Safety Information

Voltage Setting Information
The universal hood of the ChemiDoc MP imager has a power supply that automatically chooses the correct voltage for your country or region.

Fuses
The universal hood of the ChemiDoc MP imager has two user-serviceable fuses, F1 and F2, which are located on the bottom rear panel and are a part of the power entry module. See Fuse Replacement on page 215 for information about replacing the fuses.
1 Introduction

The ChemiDoc™ MP imaging system offers exceptional application flexibility, high performance, and ease of use. The imager contains a charge-coupled device (CCD) camera to capture images in real time and enable you to accurately position your sample and generate optimized image data.

The ChemiDoc MP imager uses a new generation lighttight enclosure (the universal hood III), which contains built-in UV and white light illumination as well as available red, green, and blue epi LED light sources. The imager features dynamic flat fielding technology for superior image uniformity and accurate quantification.

Image Lab™ software controls image capture and optimization for your selected applications, analyzes results, and produces reports based on your specified output, all in a single workflow.

ChemiDoc MP Imager

The ChemiDoc MP imager is a high-resolution gel documentation system that allows fast, easy quantification of gels and blots. Position your sample inside the imager and follow the onscreen steps to run a protocol with only one click. You can customize your applications within an existing protocol or create a new protocol using the many options presented in Image Lab software.

The ChemiDoc MP imager also offers sensitive chemiluminescent detection. The system includes a supersensitive 16-bit CCD camera that is deeply cooled for faint-sample detection and for accurate quantification of image data.
Introduction

Features include:

- Smart, application-based protocol setup using Image Lab software, which assists by presenting appropriate filter and illumination sources for imaging applications that require excellent sensitivity
- Exceptional sensitivity and a dynamic range greater than four orders of magnitude
- Flexibility to image chemiluminescent, fluorescent, and colorimetric samples with dynamic flat fielding specific to each application

System Components

CCD Camera and Lenses

The ChemiDoc MP imager’s camera is placed on top of a lighttight enclosure (the universal hood) for capturing images. The camera comes with a motorized zoom lens (MZL) that allows remote adjustment of the lens control functions (zoom, focus, and iris).

A patent-pending software algorithm controls the MZL, giving the user automatic image focus once an initial calibration is performed during system installation. See the ChemiDoc MP Technical Specifications on page 23 for complete specifications of the system.

A +1 diopter lens is factory installed to allow the entire sample stage to be visible. This lens should always remain on the MZL assembly.
Universal Hood III

The universal hood III is designed to capture fluorescent and chemiluminescent images without using a photographic darkroom. The enclosure has built-in white light epi-illumination and UV transillumination. For easy sample loading, the UV transilluminator is located in the drawer of the universal hood and can be accessed from the front of the enclosure. When not imaging, the lights in the darkroom enclosure turn off automatically.

The universal hood III has touchpad buttons to perform various functions; however, Image Lab software controls all of these functions remotely, removing any requirement for manual control of the lens and lights. Running a protocol overrides touchpad input.

Image Lab Software

The imager ships with a full version of Image Lab software. In addition to controlling the imager, image capture, and optimization, Image Lab software can be used to annotate and document images, analyze molecular weights (or base pairs, when imaging nucleic acid gels), and determine accurate quantification and purity of samples.

You can print all or a subset of your data in a report. Alternatively, you can export your data to other software, such as Microsoft Office programs, for further analysis or presentation options.

Emission Filters

The universal hood III can hold up to six different emission filters for fluorescent applications. No filter is required to image chemiluminescent samples.

A standard filter is used for colorimetric (white light) applications and is included in the installation kit.
Optional Accessories

Bio-Rad Laboratories, Inc. offers a selection of optional filters and illumination sources. See Ordering Information on page 243 for a complete listing of accessory filters, UV light sources, optional parts, and replacement parts.

Printer

For your convenience, Bio-Rad offers an optional USB printer for use with the ChemiDoc MP system: the Mitsubishi thermal printer (catalog #170-8089).

Conversion Screens

White Light Conversion Screen
The white light conversion screen is a phosphor screen that produces white light transillumination when placed on top of the UV transilluminator.

XcitaBlue Conversion Screen
The optional XcitaBlue™ screen kit (catalog # 170-8182) converts UV to blue light, which enables you to visualize DNA samples while protecting them from UV damage.

Optional Light Sources

Red LED Module
The optional red LED module kit contains the emission filter and excitation source for fluorescent applications. Instructions are also included.

Green LED Module
The optional green LED module kit contains the emission filter and excitation source for fluorescent applications. Instructions are also included.

Blue LED Module
The optional blue LED module kit contains the emission filter and excitation source for fluorescent applications. Instructions are also included.
## ChemiDoc MP Imager Applications

The ChemiDoc MP imager is capable of running protocols to image blots that use various detection reagents for chemiluminescent, colorimetric, and fluorescent applications. It can also image singleplex, multiplex, and stain-free gels and blots. Contact Bio-Rad technical support to determine whether your gel or blot can be imaged on this instrument.

See Chapter 4, Acquiring Images, for detailed instructions on designing protocols.

### Nucleic Acid Gels
- Ethidium bromide
- Fluorescein
- GelGreen
- GelRed
- GelStar
- OliGreen
- PicoGreen
- SYBR® Gold
- SYBR® Green
- SYBR® Safe

### Protein Gels
- Stain-free gel
- Oriole™ fluorescent stain
- Flamingo™ fluorescent stain
- SYPRO Ruby
- Krypton
- Coomassie Fluor Orange
- Pro-Q Diamond
- Pro-Q Emerald 300
- Pro-Q Emerald 488

### Blots
- Chemiluminescent reagent
- Chemi hi sensitivity reagent
- Chemi hi resolution reagent
- Stain-free blot reagent
- Colorimetric
- Alexa 680
- DyLight 488
- DyLight 549
- DyLight 649
- DyLight 680
Introduction

- Cy2
- Cy3
- Cy5
- Cy5.5
- Alexa 488
- Alexa 546
- Alexa 647
- IRDye 680
- Rhodamine
- Fluorescein
- Qdots 525
- Qdots 605
- Qdots 625
- Qdots 705
## ChemiDoc MP Technical Specifications

### Applications

<table>
<thead>
<tr>
<th>Application</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chemiluminescence</td>
<td></td>
</tr>
<tr>
<td>Fluorescence*</td>
<td></td>
</tr>
<tr>
<td>Colorimetry/densitometry</td>
<td></td>
</tr>
<tr>
<td>Gel documentation</td>
<td></td>
</tr>
</tbody>
</table>

### Hardware Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Maximum sample size</strong></td>
<td>■ Length: 28 cm&lt;br&gt;■ Width: 36 cm</td>
</tr>
<tr>
<td><strong>Maximum image area</strong></td>
<td>■ Length: 26 cm&lt;br&gt;■ Width: 35 cm</td>
</tr>
<tr>
<td><strong>Maximum image area for standard, UV-excited gels</strong></td>
<td>■ Length: 25 cm&lt;br&gt;■ Width: 26 cm</td>
</tr>
<tr>
<td><strong>Excitation source</strong></td>
<td>■ Trans-UV and epi-white are standard (302 nm included, with 254 and 365 nm available as options).&lt;br&gt;■ Optional trans-white conversion screen.&lt;br&gt;■ Optional XcitaBlue™ UV/blue conversion screen. Blue, green, and red epis.</td>
</tr>
<tr>
<td><strong>Detector</strong></td>
<td>Supercooled CCD</td>
</tr>
<tr>
<td><strong>Pixel size (H x V in microns)</strong></td>
<td>6.45 x 6.45</td>
</tr>
<tr>
<td><strong>Cooling system</strong></td>
<td>Peltier cooled</td>
</tr>
<tr>
<td><strong>Camera cooling temperature</strong></td>
<td>~30°C controlled</td>
</tr>
<tr>
<td><strong>Filter selector</strong></td>
<td>■ 6-position filter wheel&lt;br&gt;■ 1 without filter for chemiluminescence</td>
</tr>
<tr>
<td><strong>Emission filters</strong></td>
<td>■ 1 included (standard)&lt;br&gt;■ 3 optional (530, 605, 695)</td>
</tr>
<tr>
<td><strong>Dynamic range</strong></td>
<td>&gt;4.0 orders of magnitude</td>
</tr>
<tr>
<td><strong>Pixel density (gray levels)</strong></td>
<td>65,535</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dynamic flat fielding</td>
<td>Application-specific, for all applications</td>
</tr>
<tr>
<td>Instrument size</td>
<td>- Length: 36 cm</td>
</tr>
<tr>
<td></td>
<td>- Width: 60 cm</td>
</tr>
<tr>
<td></td>
<td>- Height: 96 cm</td>
</tr>
<tr>
<td>Instrument weight</td>
<td>32 kg</td>
</tr>
<tr>
<td>Operating Ranges</td>
<td></td>
</tr>
<tr>
<td>Operating voltage</td>
<td>AC 110/115/230 V nominal</td>
</tr>
<tr>
<td>Operating temperature</td>
<td>10–28°C (21°C recommended)</td>
</tr>
<tr>
<td>Operating humidity</td>
<td>&lt;70% noncondensing</td>
</tr>
<tr>
<td>Automation Capabilities</td>
<td></td>
</tr>
<tr>
<td>Workflow automated selection</td>
<td>Application driven, user-selected or recalled by a protocol</td>
</tr>
<tr>
<td>Workflow automated execution</td>
<td>Controlled by a protocol via application-specific setup for image area, illumination source, filter, analysis, focus, and reporting</td>
</tr>
<tr>
<td>Workflow reproducibility</td>
<td>100% repeatability via recallable protocols; from image capture to quantitative analysis and reports</td>
</tr>
<tr>
<td>Autofocus (patent pending)</td>
<td>Precalibrated focus for any zoom setting</td>
</tr>
<tr>
<td>Image flat fielding (patent pending)</td>
<td>Dynamic; precalibrated and optimized per application</td>
</tr>
<tr>
<td>Autorexposure</td>
<td>2 user-defined modes (intense or faint bands)</td>
</tr>
</tbody>
</table>

* Using the optional XcitaBlue kit (catalog # 170-8182) is highly recommended if performing preparative DNA applications with blue excitable stains. The UV to blue conversion screen allows you to visualize DNA samples while protecting against UV damage.
Chemidoc MP Imaging System Workflow

Following are the basic steps to acquiring, analyzing, and archiving an image using the ChemiDoc MP imaging system and Image Lab software:

1. Select an existing protocol or customize a new one.
2. Position the gel or blot to be imaged.
3. Run your selected protocol.
4. View the displayed results.
5. Optimize the analysis.
6. Generate a report.
7. Save or export the results.

For More Information

Refer to the ChemiDoc MP Installation Guide found in your ChemiDoc MP installation kit for instructions about assembling and calibrating the ChemiDoc MP imager. Refer to Chapter 2, Setting Up the Instrument with Image Lab Software for information about installing Image Lab software.

To recalibrate your imager because you have acquired new accessories, refer to Chapter 9, System Calibration.
2 Setting Up the Instrument with Image Lab Software

System Requirements

Image Lab™ software runs on Microsoft Windows XP Professional, Microsoft Windows 7, and Mac OS X. Images scanned at high resolution can be quite large. The amount of memory required for using the program is determined by the size of the images you scan and analyze.

For this reason, we recommend that you archive images on a network file server or on removable storage media. Bio-Rad can also provide an appropriate computer to use with this system. Contact your local Bio-Rad representative for more details.

Image Lab Security Edition

Note: The system requirements for Image Lab Security Edition are the same as those for the Standard Edition. The software must be installed on a computer running the Windows XP Professional or Windows 7 operating system to take advantage of the secure mode features.

Computer Specifications

<table>
<thead>
<tr>
<th>Specifications</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows XP SP3</td>
<td>Windows XP SP3 Professional</td>
</tr>
<tr>
<td></td>
<td>Windows 7, 32- and 64-bit</td>
<td>Windows 7 Professional, 64-bit</td>
</tr>
<tr>
<td></td>
<td>Mac OS X 10.6</td>
<td>Mac OS X 10.6</td>
</tr>
<tr>
<td>Processor</td>
<td>Pentium 4 or equivalent (Windows) at 2.0 GHz</td>
<td>Intel Core 2 Duo 2.0 GHz or higher</td>
</tr>
</tbody>
</table>
Installing Image Lab Software

The process of installing Image Lab differs depending on your operating system. This section explains how to install Image Lab software on a Windows PC and on a Mac.

**Note:** During the Windows installation process, you are prompted to install Image Lab Standard Edition or Security Edition. In order to enable secure mode, you must have Image Lab Administrator role privileges. Bio-Rad recommends that you create the required groups and assign the Image Lab roles to users within those groups before installing Image Lab software.

See User Names, Groups, and Roles on page 204 for additional information about the required Image Lab roles, groups, and users.

See Setting Up Users and Groups on page 219 for information about setting up groups, user names, and passwords.

**To install Image Lab on a Windows PC**

1. Insert the Image Lab software CD in your CD-ROM drive.

### Specifications

<table>
<thead>
<tr>
<th>Specifications</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard disk space</td>
<td>20 GB</td>
<td>&gt;100 GB</td>
</tr>
<tr>
<td>Memory (RAM)</td>
<td>1,024 MB</td>
<td>&gt;1,024 MB</td>
</tr>
<tr>
<td>Ports for connecting instrument</td>
<td>1 free USB 2.0 port</td>
<td>1 free USB 2.0 port</td>
</tr>
<tr>
<td>Other software (optional)</td>
<td>Microsoft Excel 2003 or later (Windows)</td>
<td>Microsoft Excel 2003 or later (Windows)</td>
</tr>
<tr>
<td></td>
<td>Office 2008 or iWork software (Mac)</td>
<td>Office 2008 or iWork software (Mac)</td>
</tr>
</tbody>
</table>
The Image Lab installer automatically launches.

2. On the Welcome screen, click Next.
3. Accept the license agreement and click Next.
2  |  Setting Up the Instrument with Image Lab Software

Note the following.

- If you are licensed to install the Security Edition but choose to install the Standard Edition, you will need to uninstall the Standard Edition and install the Security Edition before you can use it.

- If you are licensed to install the Security Edition and choose to install it, only a user assigned the Image Lab Administrator role (or group) privileges can enable and disable secure mode.

  **Note:** A user assigned the Image Lab Administrator role will not necessarily also be the network or IT administrator. You must be assigned the correct role within Image Lab to enable or disable secure mode.

  For more information, see Setting Up Image Lab Security Edition on page 37.

- If you are not licensed to install the Security Edition but choose to install it, you will be prompted for a license key when you start Image Lab.

5. Click Next.
6. A screen appears requesting your license code.

   **Note:** Your 18-digit license code can be found in the Image Lab product folder pocket.

   ![License Code Screen]

   Enter the 18-digit code in the three text boxes. The software verifies the code.

   **Tip:** If you do not know or do not have access to the code, contact your Bio-Rad customer service representative.

   **Note:** Until you provide a license code, Image Lab will function only in standard mode.

7. Click Next.

8. On the Install Location screen, accept the default location or click Change and browse to another folder.

9. Click Next.
10. On the Ready to Install the Program screen, click Install.

The wizard installs Image Lab.

![Image Lab Software installation screen]

![Installation progress]

The wizard installs Image Lab.
11. When the installation is complete, you are prompted to display the Release Notes and/or the Windows Installer log. The following screen shot is an example of the Windows Installer log.

12. Select or clear the checkboxes in the Install Wizard Completed dialog.

13. Click Finish to exit the wizard.
The Image Lab icon appears on your desktop. Follow the instructions in the next section to connect your system.

**To install Image Lab on a Mac**

1. Insert the Image Lab software CD in your CD-ROM drive.
2. Double-click the CD icon on your desktop to see the folder contents.
3. Double-click the file Image Lab.dmg.
4. Drag the Image Lab application icon into the Applications folder.

**Installing the Drivers on a Windows XP Computer**

After the instrument is connected and the power is turned on, the PC automatically recognizes the instrument, and the hardware installation wizard starts, prompting you to install the drivers.

The initial Welcome dialog box appears.

![Found New Hardware Wizard](image)

**Installing the drivers on a Windows XP computer**

1. On the Welcome dialog box, click No, not this time, and then click Next.
The dialog box listing the driver that will be installed appears.

2. By default, the radio button for Install the software automatically (Recommended) is selected. Keep the default selection and click Next.

The following warning dialog box appears.

3. Click Continue Anyway.
Windows installs the driver.

When the installation is complete, the following dialog box appears.

4. Click Finish.

A message appears briefly: Your new hardware is ready to use.

**Note:** Windows XP might prompt you to go through the driver installation a second time. If this happens, repeat this section until you receive the message “Your new hardware is ready to use.”
Installing the Drivers on a Windows 7 Computer

If you are running Windows 7, the device driver is installed during the Image Lab installation process. After successful installation, you see a message similar to the following.

![Device driver software installed successfully](image)

**Note:** During the installation process you might see a warning similar to the following. You can ignore this warning because it appears even when the driver has been installed correctly.

### Setting Up Image Lab Security Edition

**Activating and Deactivating Security Edition**


**To activate the Security Edition via the Internet**

1. Double-click the Image Lab icon on your desktop to open Image Lab.
The License Code field is populated with the 18-digit license code that you entered when you installed Image Lab.


2. Select Activate Via Internet.

3. Click Activate.
Within about 30 seconds you will receive a confirmation that your Image Lab Security Edition has been activated.

To activate the Security Edition via email

1. Double-click the Image Lab icon on your desktop to open Image Lab.
   
   
   The License Code field is populated with the 18-digit license code that you entered when you installed Image Lab.

2. Select Activate Via Create Activation Email.

3. Click Create Email.
A Save File window appears with the File name field already filled in. Do not change this file name.

4. Click Browse Folders to choose a location for the file, and click Save.

5. In your email program, create an email addressed to LSG.TechServ.US@Bio-Rad.com, with the subject line: Request to Activate Image Lab software Security Edition.

6. Attach the ActivationEmail.txt file to the email and click Send.

   The Bio-Rad Technical Support Department will process your request and reply with an email containing an attachment with your activation code.

7. When you receive your reply email, open it and save the attached UnlockCode.txt file to the folder in which you saved the ActivationEmail.txt file.

9. Select Activate Via Receive Activation Email.

![Security Edition Activation]

10. Click Receive Email.

An Open File window appears.

11. Navigate to the location where you saved the UnlockCode.txt file, select the file, and click Open at the bottom of the window.
The Security Edition activation complete window appears.

12. Click OK to close the window.

**Deactivate Image Lab Security Edition**

Image Lab can be installed on more than one computer. Bio-Rad Laboratories recommends that you install the software on only one desktop computer and one laptop. To load the Image Lab Security Edition on a second computer, the software must be deactivated on the first computer before it can be activated on another. You can deactivate the Security Edition automatically via the Internet, or you can deactivate it manually by sending a deactivation email.

**To deactivate the Security Edition automatically via the Internet**


2. Select Deactivate Via Internet.

3. Click Deactivate.
The system sends a message to the Bio-Rad Technical Support Department, a window stating that your deactivation was successful appears, and Image Lab Security Edition is immediately deactivated.

To deactivate the Security Edition via email

2. Select Deactivate Via Create Deactivation Email.
3. Click Deactivate.
A Save File window appears.

4. Navigate to the folder in which you want to save the deactivation email and click Save.

5. Create an email addressed to LSG.TechServ.US@Bio-Rad.com, with the subject line: Request to Deactivate Image Lab software Security Edition.

6. Attach the DeactivationEmail.txt file to the email and click Send in your email program.


**Enabling and Disabling Image Lab Secure Mode**

You must have Image Lab Administrator role privileges to switch between Image Lab secure mode and standard mode.
To enable secure mode

1. From the Security menu, click Security Preferences to display the Security Preferences dialog box.

2. Select Enable secure mode.

3. Click OK to display the Enable Secure Mode authentication dialog box.

4. Enter your Image Lab Administrator user name and password.

5. If you are set up on a Windows network server, type the name of the Windows domain in the Domain field.
   
   **Note:** The default is the domain on which the current Windows user is located, and this name will appear in the field.

6. Click OK to save your changes.
A message appears stating that you must restart Image Lab for the new secure mode enable setting to take effect.

7. Click OK.

The application exits.

Important: For full details on why and how to set your security preferences, see Setting Security Preferences on page 48.

To disable secure mode

1. From the Security menu, click Security Preferences to display the Security Preferences dialog box.

2. Clear the Enable secure mode checkbox.

3. Click OK.
The Admin Authentication dialog appears.

4. Enter your Image Lab Administrator user name and password.

5. If you are set up on a Windows network server, type the name of the Windows domain in the Domain field.

   **Note:** The default is the domain on which the current Windows user is located, and this name will appear in the field.

6. Click OK to save your changes.
A message appears stating that you must restart Image Lab for the new security settings to take effect.

7. Click OK.

The application exits.

Setting Security Preferences

Here are three useful definitions used in these instructions.

- **Network domain** — a remote domain-controlling computer or system which ensures that only authorized users with valid credentials can access and run Image Lab.

- **Local domain (or local computer)** — the computer on which Image Lab is running, and which ensures that only authorized users with valid user credentials can access and run Image Lab.

- **Credentials** — the valid user name and password that allows or prohibits specific user actions.

There are three possible combinations of settings in the Security Preferences dialog box.

**To choose settings in the Security Preferences dialog box**

1. To set preferences so that only users who are set up on a network domain can use Image Lab:
In the Domain to be used in authentication field, enter the name of your network domain. See To find the name of your network domain on page 222 for instructions on how to determine this name.

**Note:** The default domain name that will appear in this field is the domain on which the current user is logged in.

Do not select the Use local groups for establishing user security levels checkbox.

2. To set preferences so that only users who are domain users and who are also valid members of specific local groups can run Image Lab:

   In the Domain to be used in authentication field, enter the name of your network domain. See To find the name of your network domain on page 222 for instructions on how to determine this name.

   **Note:** The default domain name that will appear in this field is the domain on which the current user is logged in.
Select the Use local groups for establishing user security levels checkbox.

3. To set preferences so that only local users can run Image Lab:
   - In the Domain used in authentication field, enter your local computer name. See To find the name of your local domain on page 221 for instructions on how to determine this name.
     
     **Note:** The default domain name that will appear in this field is the domain on which the current user is logged in.
   
   - The Use local groups for establishing user security levels checkbox is grayed out (not accessible).
Renaming Security Groups

To rename any of the four default Security Groups

1. From the main menu, select Security > Rename Security Groups.

Note: This menu option is visible only if the person logged on to the local computer is logged on as a member of the Windows Administrators group.

2. Click in any of the four Group Name fields.

3. Enter a new name.

4. Click OK to save your changes.

Note: The new user group name must comply with standard Windows Local Users and Groups user names rules.

For more information on setting up security groups, see Setting Up Users and Groups on page 219.

Using Groups on a Local Domain

If you choose not to create or use groups on the network domain, set up local groups. Add the authorized users to the groups on the local domain. In the Security Preferences dialog box, select Use local groups for establishing user security levels.
For information about setting up users and groups for Image Lab Security Edition, see Appendix C, Setting Up Users and Groups on page 219.

**Changing Security Preferences**

Changing the domain that is used to authenticate users is a two-step process. You first authenticate on the first domain, then authenticate on the second domain. This change in domains can be performed in either of two ways. It can be performed by one individual assigned the Image Lab Administrator role on both domains, or it can be performed by two individuals, one with the administrator role on the first domain, and the other with the administrator role on the second domain. See User Authentication and Group Membership on page 219 for more information about using this dialog box.
3 Image Lab Software Overview

Image Lab™ image acquisition and analysis software works with the ChemiDoc™ MP imaging system to create a reproducible, automated, and time-saving workflow for imaging and analyzing gels.

In Image Lab, a protocol is any combination of imaging, analysis, and report settings that has been saved to run as a single workflow. Researchers can run one protocol repeatedly or easily design a wide range of protocols.

With Image Lab you can view analyzed data, edit the analysis, and produce customized reports that show precisely the settings applied in order to ensure repeatable results.

Image Lab generates two types of files:

- Protocol files describe the parameters for imaging and analyzing your gel images.
- Image files contain the imaged gel, annotations, and analysis performed on the gel. An imaged gel, run according to a protocol file, generates an image file.
Table 2 lists the extensions and icons for the type of files that Image Lab generates.

<table>
<thead>
<tr>
<th>File type</th>
<th>File Extension</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocols</td>
<td>.ptl</td>
<td>.sptl</td>
</tr>
<tr>
<td>Images</td>
<td>.scn</td>
<td>.sscn</td>
</tr>
<tr>
<td>Multichannel protocols</td>
<td>.mptl</td>
<td>.smptl</td>
</tr>
<tr>
<td>Multichannel images</td>
<td>.mscn</td>
<td>.smscn</td>
</tr>
</tbody>
</table>
Interface Overview

The following illustration shows the Image Lab main window. This section explains the main software elements.

Main Window

Image Lab displays a single main window. All image and protocol dialog boxes that present choices open in the workspace, which is the gray area of the main window.

If many screens are open in the workspace, you can make one active by clicking the title bar at the top of the selected screen. A list of open protocols and image files also appears in the main window menu. Select one to make it active.

You can view complete analyses for images or protocols one at a time or compare image results by arranging screens in the workspace.
Main Toolbar

Many Image Lab tools can be selected by clicking toolbar buttons. The Screenshot tool enables you to send a screen capture of your image to the clipboard or to save it as a file. You can view demonstrations of various functions by clicking Tutorials. The unlimited Undo and Redo buttons enable you to correct missteps easily.

Results Data

Results data associated with gel images can be viewed as an analysis table, a lane profile, a standard curve, or in a report. Different tools for viewing the results data are easily accessible from the main toolbar. These tools are described in Chapter 5, Viewing Images.

The views display the analysis for the selected image. All of the views can be displayed at the same time. See Displaying Data on page 116 for details.

Display Toolbox

The display toolbox at the top of every image enables you to display images in the most useful ways. See Chapter 5, Viewing Images for a description of each option.
Start Page

The Start Page guides you through creating, opening, and viewing protocols and images.

Analysis Tool Box

The Auto-Analysis button quickly analyzes images. The remaining tools customize the analyzed data.
An image file must be selected to make analysis tools available.

**Image Tools** enables you to flip, rotate, and crop images and to transform the image files.

**Lane and Bands** enables you to resize, adjust, and bend lanes and to detect, adjust, add, or delete bands.

**Normalization** enables you to normalize volume data in multichannel images, so you can correct for sample loading errors in your gels.
MW Analysis Tools (Molecular Weight Analysis) enables you to choose standard samples, assign standard lanes, and choose a regression method.

Quantity Tools enables you to automatically quantify bands, using either relative or absolute values.

Annotation Tools enables you to add formatted text and arrows to any area of a gel.

Volume Tools enables you to manually quantify an object inside a boundary that you define.

These tools are described in Analysis Tool Box Tools on page 129.

Status Bar

The status bar at the bottom of the main window shows the imager in use and the X and Y values for the cursor position on the image file.

Note: The status bar also displays the intensity (Int) values for the image at the cursor position. The maximum data range is 0–65,535. However, the actual range varies depending on the values contained within each image.

Tip: For multichannel images, move your cursor over a multichannel pane to display color-coded intensities for all channels.
Menu Commands

The following section describes all menu commands in the File, Edit, View, Window, and Help menus. Many commands are also available on the toolbar or the Start Page.

File Menu Commands

New Protocol enables you to create a new protocol that contains the necessary steps and choices. See Chapter 4, Acquiring Images for detailed instructions. Protocols can also be altered and stored for reuse.

Open browses the file system to retrieve a previously saved protocol file or image file.

Recent Images enables you to open a recent image file.

Recent Protocols enables you to open a recent protocol.

Save enables you to save a protocol or image file after it is named.

Save As enables you to name and store a protocol or image. Protocols are stored with a .ptl or .sptl extension. Image files are stored with an .scn or .sscn extension.

Multiplex protocols are stored with an .mptl or .smptl extension, and multiplex image files are stored with an .mscn or .smscn extension.

Create Multichannel Image enables you to create a multichannel image from single-channel images and from single channels in other multichannel images.

Split Multichannel Image enables you to split the multichannel image into individual image files. Each file has the same name as the multichannel image; the application name is appended in parentheses.

Close closes the active window.

Close All closes all the windows.
Export enables you to export gel images or analysis tables with the following options:

- **Export for Publication** — exports a displayed image to a file. You can select from .bmp, .png, .jpg, and .tif formats. The gel displays with any lanes, bands, and annotations that appear on the screen. See Exporting Gel Images for Publication on page 182 for more information.

- **Export for Analysis** — creates a .tif file that retains all gel image data. Analysis data are not included. Use this option to analyze the image in other software such as Quantity One®, FPQuest™, or InfoQuest™FP. See Exporting Gel Images for Publication on page 182 for more information.

- **Export for PulseNet** — reduces the image to an 8-bit .tif file. Resolution is limited and file size is restricted to 300 dots per inch (dpi).

- **Lane and Band Table to Excel** — exports your lane and band table data to an Excel (or Numbers on a Mac) spreadsheet.
  
  **Note:** Excel or Numbers must be installed on your computer.

- **Lane and Band Table to File** — exports as a comma-separated values (CSV) file so that your lane and band table can be opened in a database application.

- **Volume Table to Excel** — exports your volume table data to an Excel (or Numbers on a Mac) spreadsheet.
  
  **Note:** Excel or Numbers must be installed on your computer.

- **Volume Table to File** — exports as a CSV file so your volume table can be opened in a database application. See Exporting Volume Tables to File on page 185 for detailed information about exporting files.

  See Chapter 8, Exporting Results for more information about exporting files.

**Image Info** displays information about individual gel and blot images, such as acquisition date and data range, and image capture detail, such as exposure time and illumination source used. Click the Image Details, Analysis Settings, and Notes tabs to display these properties. See Image Info on page 109 for more information.
Page Setup contains print controls such as orientation (landscape or portrait), margins, printer used, and paper size.

Print displays a print preview of the gel and the header information, which includes the filename of the image, the user’s name, and the date and time it was printed. The usual Windows Print screen is available as well, enabling you to select a printer and the number of copies to print.

Exit closes Image Lab (after prompting you to save changes to your protocols or images).

Edit Menu Commands

Undo undoes the last action.

Redo restores the last action after an Undo.

Screenshot enables you to take a screen shot of the Lane Profile Window, the Standard Curve Window, or the default choice, Current Image View. The screen shot can include the name of the image, and it can be placed on the clipboard or saved in a file.

Default Imager enables users who own two or more imagers to switch between them.

Instrument Setup displays information about the instrument, including its name, serial number, camera serial number, illumination options, and last calibration. If you add accessories to the instrument, you can reset the system calibration in this dialog box.

Report Settings enables you to configure reports. This dialog box has three tabs. All of the checkboxes are selected by default. Clear the boxes to exclude information from reports. Your selections apply to all reports until you change them.

- The General tab has options for excluding or reporting information about your gel image.
The Lane and Band Table tab enables the researcher to choose whether to include all lanes or selected lanes, with appropriate identifiers. Lane profiles can also be included.

The Volume Table tab enables the researcher to choose appropriate identifiers for the volume table and provides the option of excluding the table from reports.

Preferences enables you to set naming and color preferences for your image files. This dialog box has two tabs.

- The Protocol tab shows presets for naming image files. You can choose to include a designated Prefix, User Name, Date, and/or Time in the name of your image files.
- The Colors tab enables you to choose colors for the graphic elements in your gels, such as Lane Frame, Lane, Band, Band Attribute, and MW Legend. This functionality ensures that these elements are visible, regardless of the color of the gels.

View Menu Commands

Image Overview displays the gel image with a red rectangle outlining the area visible in the larger main window. This is useful when you zoom in to a small section of an image.

Image Transform displays a histogram that enables you to adjust the light and dark values of a gel image. This adjustment does not change your data, only the way the data display on your monitor.

Operations History displays the sequence of actions performed by both the user and the software.

View System Log displays events related to running Image Lab software, including enabling or disabling secure mode, and the users who log on to or log off of the software.

View (Instrument) Log displays events related to the instrument, including calibrating the instrument and the success or failure of the calibration. This log file is visible only if Image Lab is connected to an instrument.
View (Document) Log displays events related to creating and modifying secure protocol and image files. This log file is created only when Security Edition is enabled.

Security Menu Commands

Note: This menu is only visible in Image Lab Security Edition. For more information about Security Edition, see Chapter 11, Using the Security Edition.

Security Preferences allows the Image Lab Administrator to enable and disable secure mode. In this dialog box, the administrator chooses the domain to be used for authentication and whether to use local groups for security levels.

Rename Security Groups allows a person logged on as a member the Windows Administrators group to change any of the four default Image Lab security group names (TDS_Administrator, TDS_User, TDS_Tech, and TDS_Guest).

Note: This menu option is visible only if the person logged on to the local computer is logged on as a member of the Windows Administrators group. Only users who are logged on as a member of that group maintain the authority to change any of the four default Image Lab security group names. Any changes made to these Security Group names must match the names your Windows system administrator has given those groups.

Sign Document enables users to sign images and protocols. Users enter their user name and password and provide a reason for signing. When the document is signed, the reason is saved in the System Log file.

Window Menu Commands

The Window controls enable you to show and hide multiple open image files in your workspace. A list of all currently open images and protocols appears in this menu.

Tile aligns all open image files so they are visible at the same time.

Tile Horizontal aligns all open image files from top to bottom.

Tile Vertical aligns all open image files from left to right.

Cascade stacks all open image files and protocols with overlapping title bars, so each one can be easily chosen for viewing.
Imitate Zoom changes the zoom setting of all open images to the same zoom setting as the current image file.

Imitate Transform changes the brightness and contrast of all open images to the same transform settings as the current image file.

Next cycles through all open image files from oldest to newest.

Previous cycles through all open image files from newest to oldest.

Help Menu Commands

Image Lab Help displays the help system.

User Guide displays the instruction manual in .pdf form.

About displays Image Lab software version and release date.
4 Acquiring Images

Image Lab™ software runs specific applications with repeatable workflows using configurable protocols that have a wide variety of settings. These protocols can be retrieved, revised, and reused.

In Image Lab, a protocol is any combination of settings for imaging, analyzing, and reporting that runs as a single workflow.

Image Lab supports two kinds of protocols: single-channel and multichannel. A single-channel protocol enables you to choose one application for acquisition of a single image from a gel or blot, with the exception of signal accumulation mode for chemiluminescence. Multichannel protocols allow you to sequentially acquire up to three separate images of a gel or blot, using different illumination, filter, and exposure settings, to create a combined image. The multichannel image can be viewed as an RGB (red, green, blue) color-composite image.

Note: The Image Lab software is designed to work with different imagers, some of which can only produce single-channel images. The New Protocol menu choices change depending on whether the imager supports multichannel images or not. If you are using a ChemiDoc™ MP imager and you do not see the multichannel option, check to see that your default imager selection is set to ChemiDoc MP and not one of the single-channel imagers.

To create a new protocol, do one of the following:

- Click the New Protocol button on the toolbar, and then select Single Channel or Multichannel in the menu that appears.

- In the Protocols box on the Start Page, click New Single Channel or New Multichannel.

The appropriate Protocol Setup window appears for the type of protocol you selected.
The Protocol Setup Window

Single-Channel Protocols

The left pane displays headings. Under the headings are numbered protocol steps. You can enable or disable a step by selecting or clearing its checkbox. When you select a step, the right pane of the window displays the detailed settings for that step.
You can review protocol settings by selecting Protocol Summary, which lists the settings for each step in the right pane of the Protocol Setup window.

![Protocol Setup Window](image)
Multichannel Protocols

The Protocol Setup window for multichannels has some settings that differ from the single-channel Protocol Setup window, but you work with it the same way as the single-channel Protocol Setup window.

Select a step in the left pane and configure the settings for that step in the right pane.

Click Protocol Summary in the left pane to view all your protocol settings in the right pane.

Creating a Protocol

There are three categories of settings when setting up a protocol:

- **Acquisition Settings** – settings to acquire the image
- **Analyze Image** – settings to detect lanes and bands and to analyze the molecular weight
- **Generate Output** – settings to generate the output
The three categories are listed in the left pane of the Protocol Setup window. Numbered steps in each category appear under these headings. To select an option under a protocol step, select the accompanying checkbox. Options for that step appear in the right pane of the window. To disable any step, clear its checkbox.

There are some differences in the gel imaging settings of single-channel protocols and multichannel protocols. These settings are explained in Step 1. Gel Imaging for Single-Channel Protocols on page 72 and Step 1. Gel Imaging for Multichannel Protocols on page 74, in the Protocol Setup window. The remaining steps in the protocol setup are virtually identical.

**Setting Up a New Protocol**

The following steps set up (or create) a protocol:

- **Step 1. Gel Imaging for Single-Channel Protocols** — use this step (on page 72) if you are creating a single-channel protocol

- **Step 1. Gel Imaging for Multichannel Protocols** — use this step (on page 74) if you are creating a multichannel protocol

- **Step 2. Detect Lanes and Bands**

- **Step 3. Analyze Molecular Weight**

- **Step 4. Specify Output**
Step 1. Gel Imaging for Single-Channel Protocols

To take an image of the gel or blot, you need to configure the acquisition settings for the protocol.

**To configure the acquisition settings**

1. In the right pane, click Select and choose an application from the menu. The detection reagents appear in submenus under each application type.

When you choose an application and detection reagent, any required filter or illumination source displays in the Protocol Setup window.
Choose Custom to save and run an existing application with a new name or to create and run a new application. Previously saved custom applications display here. To create a custom application, see Setting Up a Custom Application on page 94.

**Tip:** For a list of applications with all required detection reagents, light sources, and any conversion screens or filters noted, see on page 98.

**Note:** If you select the Stain Free option, you may select the gel activation time. See Appendix E, Using Bio-Rad’s Stain-Free Technology, on page 247 for more information.

2. In Imaging Area, select from the list of Bio-Rad gels or enter the image area dimensions. The red box represents the imaging area for the selected gel, and the gray rectangle represents the imager sample stage.

3. In Image Exposure, select from one of the following options:

   - **Auto Exposure** — this setting estimates an optimal exposure time and ensures the best use of the dynamic range. Intense Bands optimizes for all bands and Faint Bands makes faint bands more visible but might overexpose more prominent bands.
   - **Intense Bands** — optimizes exposure for all bands
   - **Faint Bands** — a longer exposure time is used making faint bands more visible, but more prominent bands might be overexposed
Manual Exposure — use this setting to manually override automated imaging. Exposure time can range from 0.001 to 7,200 seconds with the ChemiDoc MP imager.

After imaging a gel with automatic exposure optimization, the display provides a reference point from which to set your manual exposure time.

Note: You can view the exposure time of the image in the Image Info window (see Image Info on page 109).

Step 1. Gel Imaging for Multichannel Protocols

You must configure acquisition settings for at least two channels to create a valid multichannel protocol. Each channel can be assigned a color (red, green, or blue) so you can easily identify each channel. Configure each channel separately.
To configure the acquisition settings

1. In the right pane of the Protocol Setup window, click Configure in the Channel 1 box. The Configure Channel 1 dialog box appears.

2. Click Select and choose an application from the dropdown list that appears.

Note: Select Custom to run an existing application with a new name or to create an application unlike existing applications. See Setting Up a Custom Application on page 94 for more information.
For a list of applications with all required detection reagents, light sources, and any conversion screens or filters noted, see Application Tables on page 97.

3. **In Image Exposure**, if you select the first radio button, Image Lab acquires an image estimating an optimal exposure time. This option ensures the best use of the dynamic range.

- If you choose Intense Bands from the list, exposure is optimized for all bands.
- If you choose Faint Bands from the list, a longer exposure makes faint bands more visible, but more prominent bands might be overexposed.
- If you select the second radio button to manually override automated imaging, you can set the exposure time from 0.001–7,200 seconds.

After imaging a gel with automatic exposure optimization, the exposure time displays in the protocol so you can manually adjust it if needed.

**Note:** You can also view the exposure time of the image later, in the Image Info window (see Image Info on page 109).

**Signal Accumulation Mode** — if you are running a chemiluminescence application on the ChemiDoc MP imager, you can also use signal accumulation mode (SAM).
SAM is used to simplify the capture of a good image from a chemiluminescent sample. This sample type often requires long integration times to obtain an image that represents the best range of signal.

Rather than manually acquiring a series of independent images with different imaging times, SAM presents a series of cumulative images with progressively greater signal in each image. To run SAM you must estimate the shortest and longest times expected to generate an image with the appropriate signal intensity. You then decide how many total images to acquire in this window of time.

For example, if the minimum expected time to image the sample is 1 minute and the maximum is 5 minutes, these values are entered (in sec) in the setup window. By entering 5 in the Total number of images field, three images will be acquired between the first and last images.

To use SAM, click Signal Accumulation Mode and select Setup to display the Signal Accumulation Setup dialog box.

In this example, the bar in the Signal Accumulation Setup dialog box indicates that images will be acquired at 1 minute intervals, starting at 1 minute and ending at 5 minutes. The second 1 minute image is added to the first 1 minute image, and the final image is the result of integrating these two images. The third 1 minute image is added to the previous image, and so on, until the last image is presented.
Although SAM is useful for determining the optimum imaging time for a chemiluminescent sample, it results in data that are not as accurate as data from a single image. Signal that is near the intensity of background noise becomes increasingly masked as the number of cumulative images grows. To identify extremely faint signals in an image, reacquire it as a single image, using the time the SAM tool found to be appropriate.

4. Set the following attributes in Display Options:

- **Highlight saturated pixels** — select this checkbox to see any saturated pixels in red. This shows how much of the gel image is saturated. You can change this option later by selecting View > Image Transform.

- **Channel Color** — select a color to display the sample image. Assigning each channel a different color makes it easy to identify channels. After you set up the first channel, the second channel box becomes active.

5. Repeat steps 1–4 to set up the second and third channels, if applicable. The software determines which channels are available based on the previously selected applications. Each Configure box displays the settings for that channel.

You can reconfigure channel settings by clicking Configure in the channel box and changing the settings.
6. In Imaging Area, select from a list of Bio-Rad gels or enter the image dimensions. The red line represents the imaging area for the selected gel, and the gray rectangle represents the imager sample stage.

**Step 2. Detect Lanes and Bands**

To analyze the gel or blot, Image Lab must detect lanes and bands on the image. Lanes are detected automatically, and then the background is subtracted automatically. Refer to Using the All Lanes and Single Lane Tools on page 134 for details. Customize band detection with the following options.

**To configure the lane and band detection settings**

1. Select the Lane and Band Detection checkbox in the left pane of the Protocol Setup window.
2. In the right pane, select one of the following lane and band detection options:
- **Low Band Detection Sensitivity** — this option sets detection at a low level (25) for images with more prominent bands. Faint bands are not detected with this setting.

- **High Band Detection Sensitivity** — this option sets detection at a higher level (75) for images that are fainter. Extraneous bands can be removed later, using the Band tools in the Analysis Tool Box. See Lane and Bands Tools on page 133.

- **Custom** — select a numeric value from 1 to 100 to choose the best detection sensitivity for your sample.

**Note:** You cannot specify different sensitivity levels for individual channels of a multichannel image. The same sensitivity level is applied to all channels. After the image is generated, you can change the sensitivity level for individual channels using the Lane and Bands tools.

The following is a screen shot of the Detect Lanes and Bands window for multichannel protocols.

![Detect Lanes and Bands Window](image)

**To configure normalization settings**

1. (Multichannel protocols only) Click Normalization Channel and specify which channel to use as the normalization channel.
The selected channel is used as the normalization factor against which all other lanes in the channels are compared to normalize the volume data.

You can defer making a selection during the protocol setup and normalize your data after the image is generated. For more information on normalizing volume data, see Normalizing Volume Data on page 143.

**Note:** You must select an application for at least one channel in Step 1. Gel Imaging for Multichannel Protocols on page 74 in order to see a list of choices.

2. Select the type of normalization to use:
   - **Total Lane Protein Normalization** — one lane in the normalization channel is used to calculate the normalization factor.
   - **Housekeeping Protein Bands Normalization** — a single band of a housekeeping protein is used to calculate the normalization factor.
Step 3. Analyze Molecular Weight

Determining molecular weight depends on selecting the proper protein standards. Many protein standards are available from Bio-Rad and many different DNA standards are also available. See Appendix D, Accessories for all Bio-Rad standards and their catalog numbers.

To specify how molecular weight is analyzed

1. Select the Analyze Molecular Weight checkbox in the left pane of the Protocol Setup window.

   The software calculates the molecular weight for each band based on the specified standard.

2. To estimate the size of the molecules in the bands of your gel, enter the standard you are using.

   Alternatively, you can choose from available standards:
a. Click Change to display the Manage Standards dialog box.

![Manage Standards dialog box]

b. Use the Show dropdown list to show all, only the protein, or only the DNA standards.

c. Choose the standard that you need and click OK to exit the dialog box.

3. To create a new standard, click New in the Manage Standards dialog box and complete the fields in the Edit Standard dialog.

![Edit Standard dialog box]
a. Enter a name for the new standard.

b. Choose a standard type: protein or nucleic acid

A protein standard can be expressed in either isoelectric point (pI) or molecular weight (kDa) units. A nucleic acid standard can be expressed in base pairs (bp), kilo base pairs (kb), or mega base pairs (Mb) units.

c. Click Add to display the Edit dialog box.

Note: At least two values must be added to create a new standard.

d. Enter the value and description of your new standard and click OK to return to the Edit Standard dialog box.

e. Click Add to display the Edit dialog box again, and enter a second value and description for your new standard.

f. Click OK to save your changes and close the Edit dialog box.

g. Click OK in the Edit Standard dialog box to save your new standard.

h. Click OK in the Manage Standards dialog box to save your changes.

4. Choose the lane(s) that contain your standards by typing lane numbers or the words First and Last in the Standard Lanes field. The format is xx, xx, xx, and so on, where xx is the lane number. For example, if you run an 18-well gel and want your standards in lanes 1, 10, and 18, enter First, 10, Last.

Note: Lane detection works best when standards are placed in the first and last lanes. For nucleic acid samples, use this step to determine the size of the bands in base pairs.

For more information, see Molecular Weight (MW) Analysis Tools on page 154.

5. Select the appropriate regression method for the gel type:
Gradient gels — the linear (semilog) regression method works well for these gels because the mobility of the bands is linear to the log of their molecular weight. As an alternative, the point-to-point (semilog) method can be used if the \( R^2 \) value is not sufficient.

Fixed percentage gels — these gels have a nonlinear relationship between the gels' mobility and their molecular weight. For these gels, choose the logistic or cubic spline regression method.

For more information about regression methods, see Regression Methods on page 96.

**Step 4. Specify Output**

To specify the output of the protocol

1. Select Specify Output in the left pane of the Protocol Setup window to display output options.

2. In the right pane, you can choose to
   - Automatically print the image
Automatically print a report
Display the report

Image Lab prints to the default printer unless you select otherwise. For information about customizing reporting options, see Report on page 175.

Review Protocol Settings

Click Protocol Summary in the left pane of any Protocol Setup window to see a quick review of all protocol settings.
Creating a Multichannel Image from Single Images

You can create a multichannel image from existing single images or from single channels in other multichannel images. Only images with the same aspect ratio can be combined in a multichannel image. These images are not linked to one another. When you make a change to one image, it is not propagated to the other images.

To create a multichannel image from single images
1. Open the single images from which you want to create a multichannel image.
2. In the File menu, click Create Multichannel Image. The list of open images appears in the left pane of the Create Multichannel Image dialog box.
3. Drag each image into one of the channel boxes in the right pane. After you select the first file, the Available Open Images list displays only files with the same aspect ratio.
4. (Optional) Specify a color for each channel in the accompanying dropdown lists. The resulting multichannel image appears in the Image Preview section of the dialog box.
5. Click OK to save the multichannel image.

To replace a channel in a multichannel image
1. Open the multichannel image and the new image you want to use.
2. In the File menu, select Create Multichannel Image. The open image files are listed in the Compatible Open Images list of the Create Multichannel Image dialog box.
3. Drag the images you want to keep from the Available Open Images list (left pane) into the channels in the New Multichannel Image pane (right pane).
4. Drag the new image you want to use into one of the available channel boxes.
5. Click OK to save the new multichannel image.
Editing a Saved Protocol

You can change the protocol settings and rename the protocol using Image Lab tools.

To edit a saved protocol

1. To open a saved protocol, you can:
   - Click Open on the Start Page
   - Click File > Open on the menu bar

You can also choose a recently used protocol from the lists on the Start Page.
You see the same set of menus and choices described in Creating a Protocol on page 70.

2. To update an existing protocol, edit and then save your changes without renaming the protocol.

3. To create a new protocol:
   a. Edit the protocol.
   b. Choose File > Save As and type a different name.
Positioning the Gel

To position a gel

1. Click the yellow Position Your Gel button in the Protocol Setup window.
2. Place a gel on the imager stage and view the gel in Image Lab.
3. Use the slider below the image to zoom the image into place. You can also move the gel manually until it is centered properly on the stage.

*Note:* The Bio-Rad gel alignment template kit allows four sizes of standard agarose gels to be centered quickly and easily and ensures the consistent placement of each gel. See Appendix D, Accessories, on page 235 for more information.
Running a Protocol

To run a protocol

► Click Run Protocol in the left pane.

The software runs through the steps in imaging mode, imaging each channel. A message at the bottom of the screen indicates the channel being imaged and a progress indicator tracks the process.

Note: If you run a chemiluminescence application using autoexposure, you might see the following error message:

The sample is too faint to use the autoexposure setting. Change the Image Exposure setting to use manual exposure or Signal Accumulation Mode (SAM), then run the protocol again.

This error occurs if Image Lab, using the initial autoexposure algorithm, determines that it would take too long (approximately 30 minutes or more) to acquire an image. You can always use the manual Image Exposure setting and specify a longer exposure time.

After the images are taken, Image Lab continues with the detection, analysis, and reporting steps if these steps were selected in the Protocol Setup pane. When Image Lab has completed running the protocol, it displays the images that were acquired. You can then edit and save these images or do further analysis on them.

To end the protocol

► Click Cancel Run.
Running Signal Accumulation Mode (SAM) Protocols

You can interrupt the acquisition of images for a SAM-enabled protocol at any time by clicking Stop Acquire and Continue with Selected. The acquisition process stops and continues the protocol with the selected image. Any other images that were acquired are discarded.

At the end of the acquisition process, a thumbnail of each image appears at the bottom of the window. The last image acquired appears, by default, in the main window. You can view any of the SAM images in the main window by clicking on the thumbnail image.

Review the images, select the image you want to use in your analysis, and click Select Image and Continue. Image Lab continues to the next step in the protocol using the selected image.

**Note:** After you click Select Image and Continue, only the selected image is retained. All other images are deleted. Therefore, save any images you want to keep before continuing with the protocol. See Saving Signal Accumulation Mode (SAM) Images on page 93 for more information.
Saving Signal Accumulation Mode (SAM) Images

You can save any individual image or all images at once by right-clicking on the image and selecting an option from the shortcut menu.

To save a single SAM image

1. Right-click the thumbnail and click Save.
2. In the Save File dialog box, accept the default name for the file or enter another name. Click Save.

To save all SAM images

1. Right-click any of the images and click Save All.
2. In the Select Directory dialog, enter the name of the folder and click Select Folder.

The images are saved in the specified folder. The name of the file includes the user name, timestamp, and exposure time. For example: John Doe 2012-05-01 15 hr 44 min_Exposure_5.0sec.
Setting Up a Custom Application

Use the Manage Custom Application dialog box to save an existing application with a new name or to create an application unlike existing applications.

To create a custom application

1. Select Custom on the Applications menu to display the Manage Custom Applications dialog box. If you have stored custom applications, they display here.

2. Click New.

![Manage Custom Applications dialog box]

2. Click New.
The Create Custom Application dialog box appears.

3. Enter a unique application name.

4. Select a light source, filter, and image color from the lists.

5. Select a binning setting. Choosing a higher binning setting combines pixels to increase the amount of signal without increasing noise. While a higher setting provides optimal sensitivity for low-light applications such as chemiluminescence, it also reduces image resolution.

6. Click OK to create the custom application.
Regression Methods

A regression method is used to calculate the molecular weight of the unknown bands. The software uses the relative front and molecular weight values of the standard bands to calculate the standard curve. This standard curve is then used to calculate the values of the unknown bands. The shape of the standard curve is based on the selected regression method. Choose one of the four regression methods listed in Table 3.

If you do not have enough data points for the selected method, the molecular weight of the unknown bands is not calculated.

You can check how well each regression method fits the data in the standard curve window (see Standard Curve on page 124 for more information). The linear (semilog) regression method provides a measurement that describes how well the standard curve fits the data $R^2$ value. The closer the $R^2$ value is to 1.0, the better the data fit the standard curve.

The molecular weight of each band is displayed in the Mol. Wt./Base Pair column in the analysis table. See Molecular Weight (MW) Analysis Tools on page 154 for more information about molecular weight.

For information about the calculations behind the regression methods, see Appendix G, Regression Calculation Methods.

<table>
<thead>
<tr>
<th>Regression Method</th>
<th>Minimum number of standard bands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear (semilog)</td>
<td>2</td>
</tr>
<tr>
<td>Point-to-point (semilog)</td>
<td>2</td>
</tr>
<tr>
<td>Logistic</td>
<td>5</td>
</tr>
<tr>
<td>Cubic spline</td>
<td>5</td>
</tr>
</tbody>
</table>
The following tables list the light type and filter to be used with various stains for each application for the ChemiDoc MP imager.

### Table 4. UV, Standard filters

<table>
<thead>
<tr>
<th>Stain</th>
<th>Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethidium bromide</td>
<td>Krypton</td>
</tr>
<tr>
<td>SYBR® Green</td>
<td>Coomassie Fluor Orange</td>
</tr>
<tr>
<td>SYBR® Safe</td>
<td>Pro-Q Diamond</td>
</tr>
<tr>
<td>SYBR® Gold</td>
<td>Pro-Q Emerald 300</td>
</tr>
<tr>
<td>GelGreen</td>
<td>Chemiluminescent reagent</td>
</tr>
<tr>
<td>GelRed</td>
<td>Chemi Hi Res</td>
</tr>
<tr>
<td>Fluorescein</td>
<td>Chemi Hi Sens</td>
</tr>
<tr>
<td>OliGreen</td>
<td>Stain-free blot</td>
</tr>
<tr>
<td>PicoGreen</td>
<td>Colorimetric reagent</td>
</tr>
<tr>
<td>GelStar</td>
<td>Rhodamine</td>
</tr>
<tr>
<td>Stain-free</td>
<td>Qdot 525</td>
</tr>
<tr>
<td>Oriole™ stain</td>
<td>Qdot 605</td>
</tr>
<tr>
<td>Flamingo™ stain</td>
<td>Qdot 625</td>
</tr>
<tr>
<td>SYPRO Ruby</td>
<td></td>
</tr>
</tbody>
</table>
### Table 5. White trans standard and blue Epi filters

<table>
<thead>
<tr>
<th>White Trans, Standard Filter</th>
<th>Blue Epi (catalog #170-8285) 530/30 Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast Blast™ stain</td>
<td>Pro-Q Emerald 488</td>
</tr>
<tr>
<td>Coomassie Blue</td>
<td>Cy2</td>
</tr>
<tr>
<td>Silver stain</td>
<td>Alexa 488</td>
</tr>
<tr>
<td>Copper stain</td>
<td>DyLight 488</td>
</tr>
<tr>
<td>Zinc stain</td>
<td></td>
</tr>
</tbody>
</table>

### Table 6. Red epi filter

<table>
<thead>
<tr>
<th>Red Epi (catalog #170-8283) 695/55 Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cy5</td>
</tr>
<tr>
<td>Cy5.5</td>
</tr>
<tr>
<td>Alexa 647</td>
</tr>
<tr>
<td>Alexa 680</td>
</tr>
</tbody>
</table>

### Table 7. Green epi filter

<table>
<thead>
<tr>
<th>Green Epi (catalog #170-8284) 605/50 Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cy3</td>
</tr>
<tr>
<td>Alexa 546</td>
</tr>
</tbody>
</table>

### Table 8. XcitaBlue conversion screen

<table>
<thead>
<tr>
<th>XcitaBlue™ (catalog #170-8182) Standard Filter*</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYBR® Green (excision)</td>
</tr>
<tr>
<td>SYBR® Safe (excision)</td>
</tr>
<tr>
<td>SYBR® Gold (excision)</td>
</tr>
</tbody>
</table>
Table 8. XcitaBlue conversion screen

<table>
<thead>
<tr>
<th>XcitaBlue™ (catalog #170-8182) Standard Filter*</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>GelGreen (excision)</td>
<td>GelStar (excision)</td>
</tr>
</tbody>
</table>

* Use the Xcita Blue screen to visualize gels without causing UV damage to the DNA. This is useful when you want to excise portions of the DNA.
5 Viewing Images

After a gel is imaged, the image appears in the workspace. Many controls are available to optimize viewing and to analyze the image.

The following screen shot shows a gel image with band and lane detection as well as annotations. The labels are overlays that you can display or hide.

There are many ways to view the data associated with the results. You can view data as an analysis table, a standard curve, and a report.
Displaying Gel Images

The display toolbar is located above the gel image. Each tool is described in the following sections.

Display Gel Options

This section describes the settings in the Display Gel Options dialog box.

Annotations

You can choose whether to show text and arrow annotations that have been drawn on the image.

Lanes and Bands

You can turn on or off any image overlays, such as lane frames, lanes, bands, lane labels, molecular weight legends, and band edges.
Band Attributes

You can show the following attributes for selected lanes or for all lanes.

- Band number
- Band label
- Molecular weight
- Relative front
- Volume
- Absolute Quantity
- Relative Quantity
- Band %
- Lane %

Volumes

If you drew volume boundaries on the gel, you can display the boundaries and their volume labels.

Zoom Tools

The zoom tools resize the gel image. Click the magnifying glass with the plus sign to make the image larger. Click the magnifying glass with the minus sign to make the image smaller.

You can also zoom in on an area using the right mouse button. Right-click and drag to select the area you want to magnify. You can also resize the image by right-clicking and using the scroll wheel on your mouse.

Tip: You can return to the original view by right-clicking anywhere on the image.
Fit in Window

If you zoomed in on an area of an image, this button brings the entire image back into view.

Image Transform

The Image Transform dialog box adjusts image brightness and contrast, optimizing the image display so faint details can be seen.

The minimum to maximum range varies depending on the light and dark values present in the image. These adjustments do not change the data. They change only the way the data are displayed. The human eye cannot see as great a range as the image contains.

The frequency distribution histogram shows the total data range in the image and the amount of data at each point in the range.

Auto Scale determines an optimal setting for the image automatically. The lightest part of the image is set to the minimum intensity, and the darkest is set to the maximum.

- The High progress indicator determines which intensity value is shown at the maximum gray scale (or other color) in the gel image.
The Low progress indicator determines which intensity value is shown at the minimum gray scale (or other color) in the gel image.

The Gamma progress indicator changes the gray scale curve. A value of 1 is linear. A value <1 redistributes a greater proportion of the gray scale to the first half of the intensity values. A value >1 redistributes a greater proportion of the gray scale to the second half of the intensity values.

You can also type numerical values in the boxes next to the progress indicators. Clicking anywhere on the progress indicator bars moves the progress indicator incrementally.

Options:

- **Invert image display** — inverts dark bands on a light background to light bands on a dark background. Light bands on a dark background are inverted to dark bands on a light background.

- **Highlight saturated pixels** — when this checkbox is selected, areas of the image with saturated signal intensity (higher than a measurable range) are highlighted in red.

- **Linear or logarithmic histogram** — this adjustment changes the y-axis on the histogram to display the number of pixels at each intensity value using either a linear or a logarithmic scale.

In multichannel images, you can individually highlight the saturated pixels on a channel in red. You cannot highlight the saturated pixels in a merged image.

**For Multichannel Images**

In the Image Transform dialog box, you can make changes to only one image at a time. When you work with a multichannel image, you can select each channel, in turn, at the bottom of the Image Transform dialog box and make any changes to the image.

In addition to the adjustments described in Image Transform on page 104, you can change the color of each channel. Changing the channel color in the Image Transform dialog box automatically updates the title bar and the channel buttons on the multichannel image.
If you change the color of a selected channel in Image Transform, the change is reflected in the merged image.
You can choose a color map for your image results file. Viewing the image with a different color scheme can make it easier to see all of the elements in the image, but it does not change your data.

**Note:** In multichannel images, colors can be changed only for the individual channels. You cannot change the colors of a merged image.

The first eight color choices imitate the colors of stained gels. The remaining choices supply enough color variation to highlight small differences in the image data. The available colors include:

- Gray
- EtBr (ethidium bromide)
- Coomassie
- Stain-free
- SYBR® Green
- SYPRO Ruby
Flamingo
Silver
False color
Spectrum
Gold-Silver
Pseudo

3-D Projection

The 3-D view transforms the gel image into a solid three-dimensional model spinning in space with x, y, and z dimensions. Accentuate or diminish the relative heights of data points by pulling the slider at the bottom of the window to the right or left.

Note: For multichannel images, you can view each channel separately in 3-D. A merged image cannot be displayed in 3-D.

To view the intensity of various bands

1. Select the 3-D button in the display toolbar.
2. Click and drag the model to rotate it into your preferred view.

3. Bring the window into focus by clicking the image.

4. Press “C” to display an inverted green cone, which can be dragged around to evaluate the intensity of various bands.

5. Press “C” again to hide the tool.

**Image Info**

The Image Info dialog box provides information about the active image.

**Note:** For multichannel images, select a channel to display details for that image.

The dialog box has three tabs.

- **Image Details** — acquisition and image information appear in this tab.

- **Analysis Settings** — settings that were used when the gel was analyzed are displayed here. For example, Band Detection and Molecular Weight Analysis will appear if they were performed.

- **Notes** — on this tab you can add notes, point out the types of samples used, and add any other information about the results. You can create custom labels for the lanes in your image. In a multichannel image, the custom labels are applied to all channels.
Displaying Multichannel Images

The Multichannel View includes a pane that displays the merged channels and panes for individual channels. Application names appear in the toolbar. A yellow border surrounds the active pane.

In the display toolbox above the image, additional controls are available for viewing the multichannel image.
Multichannel View

Click the Multichannel View button to display or hide the merged image panel in the multichannel display.

You can show or hide each channel using the channel buttons.

You can merge the three channels into a single multichannel pane.

You can also specify the channels to include in the merged view using the dropdown list.
Splitting Multichannel Images

You can work separately on the images that make up the multichannel image by splitting the multichannel image into individual image files. When you split a multichannel image, a new file is created for each channel (except the RGB channel). Each new file has the same name as the multichannel image; the application name is appended in parentheses. All acquisition settings and overlays are copied to the new files.

To split a multichannel image into separate files

1. Open a multichannel image.

2. Select Split Multichannel Image in the File menu. Each channel is displayed in its own window (except the RGB channel).

3. Save each image in its own file.
Change Layout

You can choose a layout for the image panes. Clicking Change Layout shows a list of display options for the image panes. You can select from one of the four views that follow.

- Grid View

By default, multichannel images appear in grid view.
Vertical View
Displaying Multichannel Images

Horizontal View

Single View
Displaying Data

You can view results from analyzed data associated with a gel image using an analysis table, a lane profile, a standard curve, or a report.

The buttons in the main toolbar turn these views on or off. You can view your data with all views simultaneously.

Analysis Table Options

Numerical data associated with an analysis can be viewed in an analysis table. Data from the Lane and Band analysis can be viewed in the Lane and Band Table tab. If volume analysis was performed, these data can be viewed in the Volume Table tab. The buttons above the table provide options for displaying and exporting analysis table data.

To change the size of the Analysis Table window

- Move your cursor to the top of the window until it changes into a double-headed arrow. Click and drag the edge of the window until you can see all of the data.

Note: Resizing the Analysis Table window is restricted when a protocol window is open.
Display Data Options

The Display Data Options dialog box has three tabs.

- **Measurements** — enables you to choose the measurements to display in the table. Use the arrows to move the columns between the Not Displayed pane and the Displayed pane. By default, all measurements are displayed in the Analysis table.

  **Note:** For a description of each Lane and Band measurement type, see Lane and Band Table Measurement Definitions on page 119. For a description of each Volume measurement type, see Volume Measurement Definitions on page 119.

- **Display** — enables you to set the display for the analysis table. The following settings appear on the Display tab:

  - **Default display settings** — The Move selected lane to top checkbox is selected by default. When you click a lane on the image, the Analysis table scrolls so that the data for the selected lane appears first in either the vertical or horizontal view of the table.

  - **Per Measurement Precision** — set the precision (decimal places) for the measurements in the Lane and Band table and the Volume table.

  - **Example** — shows an example of how measurements will display with the selected measurement and precision settings.

- **Export** — enables you to choose how to export the analysis data. The following settings appear on the Export tab:

  - **Export formatting** — select checkboxes to include lane headers (Lane and Band table tab only) and/or column headers in the exported file.

  - **Export delimiter** — select a delimiter option for the exported file.

    - Comma delimited
    - Tab delimited
    - Use other delimiter (user defined)
Change Analysis Table Orientation

This button toggles between two table orientations.

**Horizontal** — displays the lanes/volumes beside each other, so you can scroll through the table from left to right.

**Vertical** — displays the lanes/volumes on top of each other, so you can scroll through the table from top to bottom.

Copy Analysis Table to the Clipboard

Copies the table data to the clipboard so that you can paste the data into word processing or presentation applications.

**Tip:** It is best to use the vertical table orientation when copying to an 8.5 x 11-inch page, to give the columns enough room to display.

Export Analysis Table to a File

Exports the table data as a CSV file so you can open it in a database application.

Export Analysis Table to Excel

Exports the table data to a spreadsheet so you can use the sorting and formula functions to manipulate your data. If you have Excel (PC or Mac) or Numbers (Mac) installed on your computer, the program opens with your spreadsheet displayed.
**Lane and Band Table Measurement Definitions**

This section defines the measurements that display in the Lane and Band tab in the Analysis table. Use the Data display options button to choose the columns to display.

**Band Number** — each band in a lane has a unique number, sorted from top to bottom.

**Band Label** — you can assign a custom label to each band by clicking the Band Label field of the Lane and Band table.

**Molecular Weight** — the molecular weight of the band is calculated based on the user-defined standard and regression method. Italic values indicate extrapolated values. When using nucleic acid gels, the size of the band is displayed in base pairs.

**Relative Front** — values between 0–1 indicate the relative movement of the band from top to bottom.

**Volume** — the sum of all intensities within the band boundaries.

**Abs. Quant.** — absolute quantification of the band.

**Rel. Quant.** — relative quantification of the band compared to the reference band.

**Band %** — percentage of the band’s volume compared to all band volumes in the lane.

**Lane %** — percentage of the band’s volume compared to the entire volume of the lane.

**Volume Measurement Definitions**

This section defines the measurements that display in the Volume tab in the Analysis table. Use the Display Data Options button to choose the columns to display.

**Volume Number** — a unique number is assigned to each volume.

**Volume Label** — software-generated labels for different types of volumes (U – unknown, B – background, S – standard). Label can be changed in Volume Properties.
Volume — the sum of all the intensities within the band boundaries.

Adjusted Volume — the background-adjusted volume.

Mean Background — the mean value of the background.

Absolute Quantity Volume — the quantity of the volume based on the standard volumes and the regression method.

Relative Quantity Volume — the ratio of the adjusted volume and the adjusted volume of the reference volume.

# Pixels — number of pixels inside the volume boundary.

Minimum Value — intensity of the pixel with the minimum intensity inside the volume.

Maximum Value — intensity of the pixel with the maximum intensity inside the volume.

Mean Value — mean value of all pixels inside the volume boundary.

Standard Deviation — standard deviation of all pixels inside the volume boundary.

Area — area of the volume in mm².
The Lane Profile option shows a cross-section view of a single lane rotated 90°.

**To view the lane profiles of the different channels in a multichannel image**

1. Click on the channel. The Lane Profile window updates and displays the lane profile of the selected lane in the channel.

2. Use the Next and Previous buttons to page through the lanes in the channel.

The title bar identifies which lane profile is in view (Lane 1, Lane 2, and so on). If the image is a multichannel image, the title also includes the name of the channel, for example, Lane 2 (DyLight 650).

There are several settings in the title bar.

- Scale to fit graph
- Include Background
- Identify Bands by

These settings, as well as the zoom tools, are global. They apply to all the profiles.
The zoom tools work the same way they work elsewhere in the software. For more information, see Zoom Tools on page 103.

In addition to the graph of the lane intensities, the Lane Profile tool also shows an image of the selected lane below the graph. The multichannel channel of multichannel images is always a gray scale image of the lane with the default transform applied to that lane. For single-channel images and individual channels of a multichannel image, the transform and color map are applied to the gray-scale image.

As you move your cursor over the profile, the current relative front (Rf) value and the average intensity (Int) value at the Rf value display in the lower-right corner of the Lane Profile window.

**Scale to Fit Graph**
You can choose the highest point of the display to define the range of the graph. This provides the best view of the lane profile.

You can clear the Scale to Fit Graph checkbox to display the entire range of possible intensity values in the graph. Doing so allows valid comparisons between different lanes.

**Include Background**
When the Include Background checkbox is selected, the Lane Profile window shows the subtracted background under the blue line. The area used for band quantification appears in green under the red line.

When you clear the Include Background checkbox, the area of the lane profile that represents the background of the image does not display.
**Identify Bands by**

You can change how the bands are labeled by choosing from the options in the Identify Bands by dropdown list. By default, the bands are labeled by band number.

You can display one of the following attributes:

- Band Number (Band No.)
- Band Label
- Molecular Weight (Mol. Wt.)
- Relative Front
- Volume
- Absolute Quantity (Abs. Quant.)
- Relative Quantity (Rel. Quant.)
- Band %
- Lane %
- Normalization Factor (multichannel images only)
- Normalization Volume (multichannel images only)

**Adjusting Band Boundaries**

Below the profile of each lane there is a strip that displays the bands. Each band is surrounded by a pair of vertical lines delimiting its boundaries. You can move the vertical lines and change these boundaries.

To change the boundaries of a band

1. Hold your cursor over one of the boundary lines until a double arrow appears.
2. Click and drag the cursor to the new position.

**Note:** Boundary lines cannot overlap one another. Therefore, you will not be able to move any boundary line beyond the next boundary line.
The Standard Curve dialog box displays the best curve fit for the defined standards and the bands relative to this curve for the lane selected in the image. The tabs at the bottom of the dialog box display the standard curves for three different analyses.

Standards appear in green. Unknown bands appear in red. You can toggle the molecular weight display on the y-axis between linear and log scale by clicking the Log y-axis box at the upper left. The regression method you chose in Molecular Weight Analysis Tools appears, as well as the formula (if applicable) and the $R^2$ value of the regression method.

Tabs in this window enable you to view the molecular weight standard curve, the absolute quantity standard curve, or the volume standard curve.
Report

See Generating Reports on page 175, for information about reports.
## 6 Analyzing Images

Analysis Tool Box tools are enabled when an image file is opened and in focus. An active or “in focus” window has a darker blue menu bar on a Windows PC. On a Macintosh, the window control icons display more brightly when a window is active. This distinction helps you to identify the active window among many open image files in your workspace.

### Image Types

Image Lab™ creates three types of images:

- Single-channel images
- Linked multichannel images
- Unlinked multichannel images

The multichannel view in a multichannel image is a merged display of single channels. You can have up to three images in the multichannel image. The linked multichannel image is acquired using the multichannel protocol. Unlinked multichannel images are generated by combining several images using the Create Multichannel Image feature.

The Analysis Tool Box tools work differently on these images. Some tools, such as lane detection, when applied to one channel in a linked multichannel image, propagate the changes to all the other channels. With unlinked multichannel images, lane detection must be applied separately to each channel.
Using Auto Analysis

Auto analysis detects the lanes and bands and, optionally, calculates the molecular weight of the bands in your image. Click Auto-Analysis in the Analysis Tool Box to do the following:

- Analyze images obtained with protocols that did not include steps for auto detection and analysis
- Change your analysis parameters to reanalyze your images

**Note:** If you change any settings for an analyzed gel, the initial analysis is overwritten. To preserve both analyses, save each image file with a different name.

**Note:** The Band Detection Sensitivity and Molecular Weight Analysis Settings are applied to all channels in a multichannel image. If you want to use different sensitivity levels to detect bands in each channel, use the Lane and Bands tools.

Auto Detection Settings
The band detection sensitivity options are as follows:

**Low Band Detection Sensitivity** — sets detection at a low level for images with prominent bands. Faint bands are not detected with this setting.

**High Band Detection Sensitivity** — sets detection at a higher level for images that are faint. Extraneous bands can be removed using the Band Tools in the Analysis Tool Box. See Lane and Bands Tools on page 133.

**Custom** — enables you to set a value between 1 and 100 to select the best detection sensitivity for your sample. You can also drag the sliding bar left or right to set the value.

When Low Band Detection Sensitivity is used, the numerical value is set at 25; when High Band Detection Sensitivity is used, the value is set at 75.

**Molecular Weight Analysis Settings**

**Molecular Weight Standard** — choose any of the many Bio-Rad standards or another standard you added to your standards list.

**Standard Lanes** — choose or change the lanes in which the standards are placed.

**Regression Method** — four regression methods are available. For more information, see Regression Calculation Methods on page 253.

**Analysis Tool Box Tools**

All Analysis Tool Box tools customize the analyzed data in image files. These tools are available only when an image file is open. Click a specific image to select among the many windows that might be open in your workspace.

**Note:** Some tools delete the existing analysis.

**To access a tool**

- Click any of the toolbox buttons.
To return to the Analysis Tool Box menu

- Click the green Up arrow to the right of the tool name.

**Image Tools**

The image tools enable you to manipulate your images.

To display the image tools menu

- Click Image Tools.

- **Flip** — you can flip the gel image horizontally or vertically.

- **Rotate** — you can rotate the gel image 90° using the Left or Right buttons. Or you can set a custom rotation using the Custom button.

- **Crop** — you can trim the outer edges of your image to any shape or area.

- **Invert Data** — you can toggle the image data from positive to negative.
Image Tools

- **Merge** — you can merge a chemiluminescent blot image with a colorimetric image of the same blot.

The sections that follow describe how to use these tools in greater detail.

**Correcting a Slanted Gel**

To correct a slanted gel

1. In the Rotate section, click Custom. Red arrows appear over the gel image.
2. Rotate the red arrows to any degree between 0 and 360 by dragging them.
3. Right-click the gel image and click Rotate to set your gel in the new position. Click Cancel if you do not want to set the rotation.

**Cropping a Gel Image**

You can save crop settings and use them to crop other images. This feature is useful when you want to crop the same area in several images.

To crop a gel image

1. Click Crop. A red box outlines the image area.
2. Drag the red box to surround the image area you want to keep.
3. (Optional) Right-click the image to open the Crop menu and click Save Crop Settings. The Save Crop Settings dialog box appears.
4. (Optional) Type a name for the crop settings and click OK.
5. Right-click and select Crop or Cancel. Selecting Crop crops the image to the area inside the red box.

To crop an image using saved crop settings

1. Click Crop. A red box outlines the image area.
2. Right-click the image to open the Crop menu and click Load Crop Settings.
3. Select the saved crop settings that you want to use and click Load. The red box
resizes and the crop specifications appear on the image.

4. Right-click and select Crop. The image is cropped to the area specified in the
crop settings you selected.

To delete crop settings

1. With an image open, click Crop.

2. Right-click the image inside the red box to open the Crop menu and click
   Delete Crop Settings.

3. Select the crop settings in the dialog box that appears and click Delete.

Inverting Data

Use this button to change the image data from positive to negative. Invert Data is
used for negative stains and zymograms. Intensity values of bands must be greater
than background to perform analysis on the gel. View the gel as a 3-D projection to
determine if the data must be inverted.

Merging Images

Use this button to merge a chemiluminescent blot image with a colorimetric image
of the same blot. If you have used colorimetric prestained standards for a
chemiluminescent blot, you can acquire an epi-white light image of the blot to show
the standards and a chemiluminescent image to show immunodetection. These two
images can then be merged into a combined image with both signals.

Note: Merging images can have an adverse effect on quantification. If accurate
quantification is required, perform analysis on the original, separate images.
Only images of the same size can be merged.
The Lane and Bands tools enable you to identify the lanes and bands in your images.

To open the Lane and Bands tool

- In the Analysis Tool Box, click Lane and Bands, then select the tab for the Lanes or the Bands tool.
Detecting Lanes

To detect the lanes in the image, do one of the following:

- Click Automatic if the gel image is fairly typical.
- Click Manual to detect a specific number of lanes or if automatic lane detection did not find all the lanes.

Detecting Lanes in Multichannel Images

To use automatic lane detection with multichannel images, select one of the channels and click Automatic. Automatic lane detection works differently in multichannel images depending on whether the channels are linked or unlinked.

- For linked multichannel images, the lane detection is based on the selected channel, and the lanes are detected in all channels.
- For unlinked multichannel images, lane detection is applied to only the selected channel. You must individually select each channel and apply automatic lane detection.

The lanes in unlinked multichannel images might fall in slightly different places on each channel, and you might need to have more control over where the lanes fall. You can detect the lanes in one channel of an unlinked multichannel image using either the automatic or manual lane detection tools. Then you can copy those lanes into the other channels and position them so that the lanes in each channel align with one another. For more information on copying lanes, see Copying Lanes on page 138.

Using the All Lanes and Single Lane Tools

To use the All Lanes and Single Lane tools

- Click the lane tool first, then click the lane to which you want to apply the change. Tool actions in linked multichannel images are applied across all channels. Tool actions in unlinked multichannel images are applied in only the selected channel.
All Lanes Tools

You can modify all the lanes in your image using these tools.

- **Resize** — resizes the lanes in your image. Click Resize and then drag the handles of the red squares to resize all lanes.

- **Adjust** — adjusts the orientation of all lanes. Click Adjust and then drag a single corner of the lane frame. The Adjust All Lanes tool does not resize lane width.

  You can add anchor points to the top or bottom borders of the rectangle by clicking the lane frame. Remove any unneeded anchor point by right-clicking it. By dragging these additional anchor points, you can adjust for “smiling” gels.

  **Note:** You can move the entire lane frame when resizing or adjusting the lanes. Click Resize or Adjust and make the changes to your lanes. Then click anywhere in the frame and move it to the desired location.

- **Delete** — deletes all lanes.

- **Width** — changes the width of all lanes at the same time. Click Width and then drag one of the anchor points on any lane to change the width of all lanes. In a multichannel image, the width of all the lanes in all channels are changed.

  **Tip:** You can use the plus key (+) on your keyboard to increase the lane width, and the minus key (-) to decrease the width.

  You can also change the lane width by specifying the size of the lanes. Click Width, enter a number (in mm) in the box, and click Apply.

  **Note:** You might see that the number in the box changes after you click Apply. For example, you enter 5.75 and the number changes to 5.71. The image is made up of pixels and the Image Lab™ software can only draw a boundary for the lane between pixels. If the number you specify would
cause the boundary to fall anywhere on the pixels, Image Lab moves the boundary so that it falls between two pixels and updates the number accordingly.

**Note:** The All Lanes Width tool makes the width of all lanes uniform. Therefore, if you used the Single Lane tool to change the width of an individual lane, this change is overridden by the All Lanes Width tool.

**Single Lane Tools**

Specific information about how to use each lane tool is described in the following section. You can modify an individual lane in your image using these tools.

- **Add** — adds a lane to a gel image. Click Add, then click within the lane frame where you want to place the new lane. The lanes are automatically renumbered.

  **Note:** To add a lane outside the frame, add a lane inside the frame and click Move to expand the lane outside the frame's boundaries.

- **Delete** — deletes a lane. Click Delete, then click either the lane or its lane number. The lanes are automatically renumbered.

- **Bend** — bends a lane to better fit the gel image. Click Bend, then drag square anchor points to fit the lane to the image.

  **Note:** To add anchor points, left-click within the lane. Drag these anchor points to adjust the lane to fit the gel image. To remove an anchor point, right-click on it.

- **Move** — moves a lane to a new position on a gel image. Click Move, then click the lane you want to move. Drag it to a new location. The lanes are renumbered according to their new positions.

- **Width** — changes the width of a lane. Click Width, then click within the lane. Click on the anchor points to adjust the lane width.
You can also change the lane width by specifying the size of the lanes. Click the Width button, enter a number (in mm) in the box, and click Apply.

Note: You might notice that the number in the box changes after you click Apply. For example, you enter 5.75 and the number changes to 5.71. The image is composed of pixels and the software can draw a boundary only in the lane between pixels. If the number you specify would cause the boundary to fall anywhere on the pixels, Image Lab moves the boundary so that it falls between two pixels and updates the number accordingly.

**Lane Background Subtraction**

**To perform lane-based background subtraction**

- Select Enable Subtraction in the Background Subtraction field. Use the Lane Profile view to see the subtracted lane background.

**Disk Size** — specifies the size of a hypothetical rolling disk (between 0.5 and 99.5 mm in 0.5 mm increments) that removes background levels along the length of the lane. The size of the disk determines how closely the background level follows the intensity profile.

A large disk follows the profile trace less closely, touching fewer points along the trace and removing less background. A smaller disk more closely follows the profile trace, removing more background.

A disk radius that is too large will result in poor background removal. A disk radius that is too small might subtract actual data. For most samples, a size of ≤10 mm is usually appropriate. You can perform this task several times until you are satisfied with the amount of background removed. Use the Lane Profile tool to evaluate the appropriate disk size for background subtraction.

**Apply to selected Lane** — applies the specified level of background subtraction only to the selected lane. This option enables you to set different background subtraction levels for each lane.
Copying Lanes

You can copy the lanes from one image into any other image. This tool is useful if you want to create a multichannel image from unlinked images, and you want to identify and match the lanes in your channels. The entire frame and all the lanes are copied. Individual lanes cannot be copied.

To copy lanes between channels

1. Open the Lane and Bands tool.
2. Select the channel that contains the lanes you want to copy.
3. From the Edit menu, select Copy.
   
   The message Copying All Lanes appears.
4. Select the channel that you want to copy the lanes into.
5. From the Edit menu, select Paste.

   A channel can contain only one lane frame at a time. Therefore, if you paste lanes into a channel that already contains a lane frame, you are prompted to confirm the deletion of the existing lanes. If you click Yes, the existing lanes are deleted and replaced with the copied lanes.

   **Note:** If you copy lanes into a channel of a linked multichannel image, the lanes are copied into all channels of the image, including the Multichannel channel.

After the lanes are copied into the channel, you can manipulate individual lanes using the lane tools so that they are correctly positioned.

Detecting Bands

**Note:** Bands are detected for individual images. For multichannel images, you must detect the bands for each channel, one at a time. This applies whether the multichannel image is linked or unlinked. Band detection on the Multichannel channel is disabled. The multichannel view is a composite of the other channels. Detecting bands in this view is not particularly useful because quantifying overlapping bands will result in combined values from multiple channels.
To detect bands in the image

- Click Detect Bands to open the Band Detection dialog box. Select band detection sensitivity and the lanes to which it applies.

Note: With multichannel images, you can leave the Band Detection dialog box open as you select each channel one by one and detect the bands in each channel. You do not have to close and reopen the dialog box for each channel.
**Displaying Advanced Detection Options**

You can also select Display Advanced Options to set specific parameters for band detection. When initially expanded, the values in Advanced Options are set in relation to the band detection sensitivity that you select in Detection Settings. You can set specific parameters for the sensitivity level and apply the parameters to all lanes or to a specific lane.

If later you change the band detection sensitivity in Detection Settings, the values in Advanced Options change in relation to the new sensitivity levels. You might need to reset these parameters to the original values.
Advanced Detection Options

- **Sensitivity** — determines the minimum optical density that will be defined as a band. The higher the sensitivity value, the lower the minimum signal intensity, therefore the more bands will be detected.

  If the sensitivity is set too high, background staining might be detected as bands. If the setting is too low, bands of interest might not be detected.

  The default sensitivity setting is 10.0. If the gel has faint bands (for example, if the optical density is less than 0.05, and counts are less than 2,000), you may want to increase this value to 20.0.

- **Size Scale** — distinguishes between trends in signal intensity and random intensity fluctuations. It is the number of pixels in a vertical column that are taken together to determine whether a band is present.

  The Size Scale parameter uses the size of objects in the image to determine the nature of those objects. If a gel image has high levels of background noise, a larger size scale is appropriate. At low noise levels, a smaller value is preferable. You can also increase the size scale if the gel has only a small number of thick bands scanned at high resolution.

- **Noise Filter** — minimizes the number of small fluctuations (or noise) in the image that are called bands while still recognizing larger features (the real bands). This filter becomes especially important at higher sensitivity levels.

  The noise filter value refers to the size of the filter in pixels (for example, a value of 2.50 equals a filter size of 2.50 x 2.50 pixels). Features smaller than the filter size will not be recognized as bands. Entering a noise filter size of zero turns it off completely.

  If band detection identifies doublets as single bands, decrease the noise filter setting and/or increase the sensitivity level.

  **Tip:** You can also decrease the Size Scale parameter instead of the noise filter to improve the detection of closely spaced bands. However, if you decrease both the noise filter and the size scale, the fuzziness around bands might be mistakenly detected as separate bands.
Shoulder — band detection tries to distinguish shoulders as separate bands. When looking at a lane trace, these bands appear as flat or gently sloping abutments to darker, better-defined bands (that is, there is no dip on the trace between the two bands). Increasing the shoulder sensitivity results in more shoulders being detected as bands. Changing this setting to zero results in no shoulders being recognized as separate bands.

If band detection calls a doublet a single band, check the lane trace to see if there is a dip between the peaks of the two bands. If there is no dip, increasing the shoulder sensitivity value will help resolve the two bands.

Normalize Sensitivity — compensates for differences in intensity between lanes.

The intensity of each lane is determined by the darkest band in that lane. For example, suppose that in all but one of the lanes the darkest band has an intensity of 50,000 counts. In the light lane, the darkest band is only 25,000 counts. With normalization, band detection will be twice as sensitive when processing the light lane, improving the detection of faint bands.

Note: It does not normalize for band quantitation.

Band Limit — enables you to limit the number of bands that will be detected in each lane, thus reducing the need for later editing.

Editing the Detected Bands

You can optimize the bands in your images using these tools.

Add — manually add a band to a lane. Click Add, then click at the desired location in a lane. Image Lab then locates a faint band close to where you clicked.

Tip: You can darken your entire image to view faint bands more easily using the sliders in the Image Transform dialog box. For instructions, see Image Transform on page 104.
Normalizing Volume Data

- **Delete** — deletes a band from a lane. Use this feature to remove bands that are not relevant to your analysis. Click Delete, and then click on the band you want to remove.

- **Adjust** — adjusts the height of a band. Click Adjust. Boundary lines appear on either side of each band. Move the cursor over a boundary line until you see a double-headed arrow. Move the boundary line up or down. The center is recalculated and the band appears there.

  **Note:** You can also adjust band boundaries in the Lane Profile view.

**Normalizing Volume Data**

There are several reasons why you might want to normalize the volume data in multichannel images:

- The lanes are loaded with the same volume, but you do not know the total protein in each lane.
- Pipetting errors result in variations in the lane volumes.
- Differences occur in the transfer of protein from a gel to a membrane.

You can correct for these differences by normalizing the volume data. There are two ways to normalize volume data:

- **Total Lane Protein Normalization** — one lane in the normalization channel is used to calculate the normalization factor.

- **Housekeeping Protein Bands Normalization** — a single band of a housekeeping protein is used to calculate the normalization factor. In order to get accurate results, the housekeeping protein must be stable and impervious to the treatments in your experiment. It must be the same in pretreatment and post-treatment.

In both cases, the normalization factor is then used to calculate the normalized volumes in the lanes for all channels.
Using the Normalization Tool

Click Normalization on the Analysis Tool Box.

The Normalization Steps guide you through the steps to normalize your volume data.

The Normalization Steps outline the recommended steps to follow. You will need to review your lanes and bands and possibly make adjustments to them.

**Tip:** From the Normalization tools pane, click Adjust Lanes/Bands to quickly navigate to the Lane/Bands Tool.

See Optimizing Normalization of Volume Data on page 145 for an explanation of each step in the process.
Optimizing Normalization of Volume Data

Follow these steps to get the best results when normalizing your volume data:

1. Detect the Lanes in the Channels
2. Make Adjustments to the Lanes
3. Detect the Bands
4. Subtract any Extraneous Background
5. Remove Compromised Data
6. View the Data in the Analysis Table
Detect the Lanes in the Channels

Start by detecting the lanes in your multichannel image. You can use either the automatic or the manual lane detection method. For more information on when to use each method, see Lane and Bands Tools on page 133. If your multichannel image consists of unlinked images, you will need to pay particular attention to the lanes that are detected to ensure that the corresponding lanes are correctly mapped for each channel. For example, you can use the Copy Lanes tool to map your lanes. For more information on that tool, see Copying Lanes on page 138.

Make Adjustments to the Lanes

Regardless of which method you use to detect your lanes, you should review the lane borders to ensure that each lane encompasses all the protein in a particular lane, and that the lane does not overlap into another lane. For example, in the following figure, lanes were detected using the automatic lane finder. Some of the lanes exclude material that should be included.

Note: Image Lab automatically excludes standard lanes from normalization.
Use the Lanes tools to make the necessary adjustments to your lanes. For more information on these settings, see Using the All Lanes and Single Lane Tools on page 134. In this example, the lanes were slightly widened to include the relevant material. The corrected image follows.
Detect the Bands

Use the band detection tool to detect the bands in the channels. If you are using the total lane protein method to normalize your data, it is recommended that you do not use the band detection tool on the normalization channel, because this will generate large amounts of superfluous data in the analysis table. For more information, see Detecting Bands on page 138.

If you are using a housekeeping protein to calculate the normalization factor, you must isolate this protein in your image. Remove all bands other than the housekeeping protein from your image. The normalization channel should have only one detected band in each lane. Use the Delete Bands tool to exclude all other bands from the calculation.
Subtract any Extraneous Background

The lane volume data is background-subtracted. Review the background subtraction being applied to each lane by using the Lane Profile tool. Verify that an equivalent background profile is being subtracted from each lane in the normalization channel so the normalization factor is accurate. For more information on the lane Background Subtraction tool, see Volume Background Subtraction on page 172.

Remove Compromised Data

There are several reasons why lanes should be excluded from your analysis:

- **Empty lanes** — the first nonstandard lane in the selected channel is used as the normalization factor against which all other lanes in all the channels are compared. If the first nonstandard lane is not a valid lane (for example, an empty lane), delete it from the channel.
**Lanes contain saturated pixels** — check your images for saturated pixels, indicated in red. These points cannot be read and cannot be used in quantification.

**Poor transfer quality** — check the quality of the transfer. If the transfer is poor with splotchy or blurred areas, delete these lanes.

**View the Data in the Analysis Table**

The first nonstandard lane in the selected channel is used as the normalization factor against which all other lanes in all the channels are compared. The normalization values are calculated based on the total background-corrected signal in the selected channel.
The Analysis Table displays the uncorrected and normalized volumes, as well as the normalization factor used to calculate the normalized volume.

**Tip:** Omit the normalization channel from the Analysis Table using the Multichannel View button. (See Displaying Multichannel Images on page 110 for information on displaying and hiding channels.)

<table>
<thead>
<tr>
<th>Channel</th>
<th>Band No.</th>
<th>Volume (pH)</th>
<th>Norm. Factor</th>
<th>Norm. Vol. (pH)</th>
</tr>
</thead>
<tbody>
<tr>
<td>DLight 658</td>
<td>1</td>
<td>21,980,420</td>
<td>0.173</td>
<td>3,765,624</td>
</tr>
<tr>
<td>DLight 549</td>
<td>1</td>
<td>4,098,050</td>
<td>0.173</td>
<td>693,885</td>
</tr>
<tr>
<td>DLight 652</td>
<td>1</td>
<td>7,029,422</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DLight 949</td>
<td>1</td>
<td>9,599,044</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DLight 115</td>
<td>1</td>
<td>11,413,154</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DLight 458</td>
<td>1</td>
<td>15,497,458</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DLight 459</td>
<td>1</td>
<td>11,215,450</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DLight 172</td>
<td>1</td>
<td>20,388,178</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DLight 174</td>
<td>1</td>
<td>16,441,174</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Adding a Channel to a Single Image**

The Normalization tool can be used only with multichannel images. If you have a single image, there is an Add Channel feature in the Normalization tools pane that guides you through the process of creating a multichannel image. After the multichannel image is created, you can use the tool to get normalized values.
To use the Normalization tools with a single image

1. Click Normalization in the Analysis Tool Box.

2. Click Add Channel to open the Add Normalization Channel window.

   **Note:** The image that is selected when you click Add Channel is the first image in your multichannel image.

   The selected image appears as the first image in the Sample Data field.
3. To add a second image, double-click on an image from the Compatible Open Images list.

   If no images appear in the list or you want to use a different image, click Browse to navigate and select the desired image.

   **Note:** Image Lab checks to see if the image has the same aspect ratio as the Sample Data image. If the aspect ratio is not compatible with the Sample Data image, it will not appear in the list of Compatible Open Images. The aspect ratios might not be compatible if they were created using different instrument models (for example, Gel Doc™ EZ and ChemiDoc™ MP) or if the images are cropped at different aspect ratios.

   **Tip:** You can move an image to the Normalization Data box by dragging it from the Compatible Open Images list, and you can remove it by dragging it back to the list.

4. Click OK.

   The Auto-Analysis window appears, prompting you to detect the lanes and bands in your images.

5. In the Auto-Analysis window, select the level of sensitivity and click OK.

6. Follow the Normalization Steps listed in the pane to get the best results.

   See Optimizing Normalization of Volume Data on page 145 for an explanation of each step in the process.
Molecular Weight (MW) Analysis Tools

Molecular Weight Analysis tools enable you to determine molecular weight (or base pairs, if using nucleic acid gels) by comparing a test sample with known standards.

Note: Before you can use the Molecular Weight Analysis tools, you must detect the lanes and bands in your image.

You can view each band’s molecular weight in the molecular weight column of the Lane and Band tab in the Analysis Table.

You can also display the molecular weight of the bands on the gel image by opening the Display Gel Options window and selecting Mol. Wt. from the dropdown list in the Band Attributes section. (See Displaying Gel Images on page 102 for information about displaying band attributes.)
Molecular Weight Standard

You can change the standards to ones that are relevant to your samples.
To change standards

- Click Change to access the Manage Standards dialog box. Choose another standard or add your own standards.

### Standard Lanes

Standard samples are placed in the first and last lanes by default. You can specify other standard lanes by selecting the box below each lane or by entering the standard lane numbers separated by commas in the MW Analysis Tools dialog box. In the Lane and Bands view, Std appears below the lanes, identifying them as standard lanes. In the Molecular Weight Analysis view, these lanes are indicated with a check mark below the lane.
Molecular Weight Analysis in Single-Channel Images

There are three standard lanes in the screen shot below (lanes 1, 16, and 17). Standard lanes are identified with a check mark in the boxes below the lane. The molecular weights of the bands in the standard lanes appear on either side of the lane frame. The red lines running from one end of the lane frame to the other identify the location of the bands in the standard lanes. You can use these lines to see where the bands in the other lanes fall relative to the bands in the standard lanes.

**Note:** You can use the lane labels to identify your standard lanes.
The values for the molecular weight in any standard lane appear in bold. In this example, the values for the first lane are in bold. (Lanes 16 and 17 are not included in the screen shot, but their values would also be in bold.) The molecular weight of the bands in the remaining lanes is calculated relative to these standards.

### Molecular Weight Analysis in Multichannel Images

Molecular weight analysis is performed differently in multichannel images depending on whether the channels of the image are linked or unlinked. If the channels are linked, then the standard lanes are synchronized across all channels. If the channels are unlinked, each channel has its own standard.

When you select the standard lane in one channel of a linked multichannel image, the same lane is selected as the standard in all other channels. The combined data in the multichannel image are used to detect the bands in this standard lane and these bands are synchronized across all channels. All the bands in all the channels are calculated using the same standard lane. If you deselect this lane as the standard, the bands in the standard lane are deleted from all channels, including the multichannel image.

With unlinked multichannel images, each channel is treated independently as if it were a single-channel image. You select a standard lane for each channel and the molecular weight is calculated for only the bands in that channel.

In the following screen shot, lane 1 in the linked multichannel image is selected as the standard lane for all channels. Because the images are linked, the same molecular weights for the standard lane and the same red lines showing the location of the bands in the standard lane are displayed in all channels.
The molecular weights of the bands in the three channels are calculated based on standards established in lane 1 and are displayed in the analysis table.

<table>
<thead>
<tr>
<th>Lane 1</th>
<th>Channel</th>
<th>Band No.</th>
<th>Mol. Wt. (kDa)</th>
<th>Lane 5</th>
<th>Channel</th>
<th>Band No.</th>
<th>Mol. Wt. (kDa)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>DyLight 650</td>
<td>1</td>
<td>268.8</td>
<td></td>
<td></td>
<td>DyLight 650</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>DyLight 650</td>
<td>2</td>
<td>186.8</td>
<td></td>
<td></td>
<td>DyLight 650</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>DyLight 650</td>
<td>3</td>
<td>106.8</td>
<td></td>
<td></td>
<td>DyLight 650</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>DyLight 650</td>
<td>4</td>
<td>59.8</td>
<td></td>
<td></td>
<td>DyLight 650</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>DyLight 650</td>
<td>5</td>
<td>37.8</td>
<td></td>
<td></td>
<td>DyLight 650</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>DyLight 650</td>
<td>6</td>
<td>25.8</td>
<td></td>
<td></td>
<td>DyLight 650</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>DyLight 650</td>
<td>7</td>
<td>17.8</td>
<td></td>
<td></td>
<td>DyLight 650</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>DyLight 650</td>
<td>8</td>
<td>11.8</td>
<td></td>
<td></td>
<td>DyLight 650</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>DyLight 650</td>
<td>9</td>
<td>8.8</td>
<td></td>
<td></td>
<td>DyLight 650</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>DyLight 650</td>
<td>10</td>
<td>3.8</td>
<td></td>
<td></td>
<td>DyLight 650</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>DyLight 546</td>
<td>1</td>
<td>268.8</td>
<td></td>
<td></td>
<td>DyLight 546</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>DyLight 546</td>
<td>2</td>
<td>186.8</td>
<td></td>
<td></td>
<td>DyLight 546</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>DyLight 546</td>
<td>3</td>
<td>106.8</td>
<td></td>
<td></td>
<td>DyLight 546</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>DyLight 546</td>
<td>4</td>
<td>59.8</td>
<td></td>
<td></td>
<td>DyLight 546</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>DyLight 546</td>
<td>5</td>
<td>37.8</td>
<td></td>
<td></td>
<td>DyLight 546</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>DyLight 546</td>
<td>6</td>
<td>25.8</td>
<td></td>
<td></td>
<td>DyLight 546</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>DyLight 546</td>
<td>7</td>
<td>17.8</td>
<td></td>
<td></td>
<td>DyLight 546</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>DyLight 546</td>
<td>8</td>
<td>11.8</td>
<td></td>
<td></td>
<td>DyLight 546</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>DyLight 546</td>
<td>9</td>
<td>8.8</td>
<td></td>
<td></td>
<td>DyLight 546</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>DyLight 546</td>
<td>10</td>
<td>3.8</td>
<td></td>
<td></td>
<td>DyLight 546</td>
<td>10</td>
</tr>
</tbody>
</table>
Regression Methods

There are four regression methods.

- Linear (semilog)
- Point-to-point (semilog)
- Logistic
- Cubic spline

See Regression Calculation Methods on page 253.

Quantity Tools

You can quantify bands in test samples automatically using either the Relative or Absolute tab under Quantity Tools.

Relative Quantity Tab

To compare the relative quantities of bands

1. Select the Relative tab.

2. Click Select.
3. Click the band you want to use as a reference. A small R appears near the band you selected.

To review the relative quantities of bands

- Go to the Rel. Quant. column of the Analysis table (Lane and Band tab). The relative quantity is the ratio of the band volume divided by the reference band volume.

All other bands now display numerical values that are relative to the reference band. If the reference band value is 1.00, values higher than 1.00 indicate that the band quantity is greater than the reference band. Values lower than 1.00 indicate the band quantity is less than that of the reference band.
Absolute Quantity Tab

Absolute quantification is used to quantify bands based on known standard bands using a calibration curve.

To calculate the absolute quantities of the bands

1. Select the Absolute tab.

2. Click Select.

3. Select at least two standard (known) bands and assign quantity values. Small A's appear (shown below circled in red) near the bands you selected.
The values display in the Standard Bands table. The greater the number of known bands and the wider the range of their values, the more accurate the absolute quantity calculation of the unknown bands will be.

### Quantity Tools

<table>
<thead>
<tr>
<th>Unit</th>
<th>Band</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>2</td>
<td>4.0</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>1.0</td>
</tr>
</tbody>
</table>

**Note:** Any standard band selection can be deleted. To do so, select the entry in the Standard Bands field and then click Delete.

4. Select a unit of measure from the Units dropdown list.
5. Select a regression method from the dropdown list.

Consider the following guidelines when making your choice.
**Linear** — generates a straight line that is the best fit of the values you provided and is preferred in most cases.

**Point-to-point** — generates a curve in which each data point is connected directly to the next, regardless of the shape of the resulting curve.

**Cubic spline** — generates a smooth curve that connects each data point. At least four standard points are required to use this method of least-squares polynomial fits.

### Table 9. Regression Methods

<table>
<thead>
<tr>
<th>Regression Method</th>
<th>Minimum Number of Standard Bands</th>
<th>Minimum Number with Force Through Origin Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Point-to-point</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Cubic spline</td>
<td>5</td>
<td>4</td>
</tr>
</tbody>
</table>

6. Click Standard Curve on the toolbar and select the Absolute Quantity Standard Curve tab.
The calibration curve displays. Standards are represented by green triangles. Unknown values are represented by red triangles.

**Note:** Selecting the Force Through Origin checkbox always starts the standard curve graph at 0,0, regardless of the best curve fit.

**Note:** Clicking the Standard Curve table generates a crosshair tool that displays the numerical values associated with the placement of the cursor in the graph.
Annotation Tools

You can annotate results with text and arrows to emphasize areas of interest.
Add Annotations

- **Text** — enables you to add text annotations to images to emphasize important details. Click Text, then click an area on the image where you want to insert your comment. A box appears with a dotted-line border. Type your comment in the box.

  **Tip:** To add a new line to the box, place your cursor where you want the break and press Shift+Enter.

**To move the box**

- Click and drag the box to change its position.

- **Arrow** — enables you to add arrows to images to emphasize important details. Click where you want the arrow to start and drag to stretch the arrow point to the location you want to emphasize. To move the arrow on the image, click the middle of the arrow and drag it to the new position.

**To change where the arrow points**

- Click either end of the arrow. Square boxes appear. Drag a box to change the length or orientation of the arrow.

  **Note:** In multichannel images, you can add annotations in all the channels. Each annotation, including the merged channel, is channel specific.

Alignment

The alignment buttons enable you to align multiple annotations, such as lane numbers, which you have manually added.

**To select multiple annotations**

- Press the Ctrl key (Command key on a Mac) and click each item or drag a selection box around them.

  **Note:** In multichannel images, you can also copy annotations from one channel to another using the same method.
Text Properties

You can change the type size and font of your text annotations.

- **Font** — click the box you want to change. Open the dropdown Font menu to show all fonts installed on your system. Select a new font for the text annotation.

- **Size** — click the box whose font you want to resize. Open the dropdown Size list to increase or decrease the size of the text. You can set the font size from 6 to 72 points using the dropdown list.

Color

You can change the color of text annotations to make them visible with any color scheme and emphasize them further by adding a color to the annotation’s background, which is invisible by default.

**To change the color of multiple items**

- Press the Ctrl key and click each item.

- **Foreground** — click a text annotation or arrow. This activates the Foreground field, so you can select a foreground color from the dropdown list.

- **Background** — click a text annotation. This also activates the Background field so you can select a background color from the dropdown list.

Rotate

You can rotate text annotations 90° to the left or right by clicking the Rotate buttons.
Volume tools enable you to manually quantify features on a sample image when automated lane and band analysis is not appropriate or possible, such as in dot blots.

**Note:** The analysis table displays the color-coded volume drawn for each channel of a multichannel image. In multichannel view, you can draw a volume on individual panes, but you cannot draw a volume on the Multichannel pane.

You can use Volume tools to quantify the signal intensity of bands, spots, arrays, and other image data. Define an area of interest by surrounding it with a shape. You can choose a rectangle, circle, freehand, or lane shape by clicking the appropriate button under the Volumes field.
A default label appears within the shape drawn. The volume label is assigned a sequential number and can be one of three types:

- U — unknown
- Std — standard
- B — background

Each new volume you create initially has a red border, which indicates that the volume is selected. When you click elsewhere on the image, the border changes to blue, indicating that the volume is no longer selected.

**Note:** Double-click a volume area to change its properties.

**To review data for the volumes**

- Open the analysis table and select the Volume tab. Volumes are listed based on their number and/or the associated information per volume. See **Volume Measurement Definitions** on page 119.

**Note:** In multichannel images additional column bars, channel numbers, and volumes are color-coded based on their channel association.
**Volume Types**

You can define the volume type (unknown, standard, or background), the quantity of standard volumes, or enter a custom name to replace the default label.

**Unknown** volumes are volumes you want to quantify.

**Standard** volumes are used for absolute quantities. See Absolute Volume Quantity on page 173.

**Background** volumes are used to remove the background from the calculation. The result of volume background subtraction appears in the Adjusted Volume column of the analysis table (Volume Table tab).

**Note:** This volume type needs to be assigned only when using Global Background subtraction.
Volume Background Subtraction

When you draw a volume, some nondata background pixels might be included inside the volume. These background pixels usually have an intensity value that you do not want to include in your volume quantification. There are two methods of calculating this background intensity for your volumes: local and global.

- **Local** — local background subtraction calculates a separate background intensity for each unknown and standard volume you create. For each volume, the intensities of the pixels in a 1-pixel border around the volume are added together and divided by the total number of border pixels. This gives an average intensity for the background around each, which is then subtracted from the intensity of each pixel inside the volume. If the background value is greater than the pixel value inside the volume, the background-adjusted quantity of the volume could be <0. In this case, redraw the border for this volume.

- **Global** — global background subtraction calculates a single background intensity for the entire gel. This average background intensity is then subtracted from all the volumes in the gel. The average intensity of the pixels in the background volume is calculated and subtracted from each pixel in all standard and unknown volumes. Therefore, it is not necessary for the background volume area to be the same size as your unknown.

**To calculate global background subtraction**

1. Use one of the Volume Tools to create a volume in a representative background region of your image (that is, a nondata region similar to the background surrounding your data).

2. Double-click the volume. This opens the Volume Properties dialog box.

3. Select the Background option button.

**Note:**

- If you select Global in the Volume Tools toolbox but do not define a background volume as described, no background subtraction is performed.
If you create more than one background volume, all the pixels in those background volumes are used to calculate the average background. Your background volume(s) will have default names B1, B2, and so on based on the sequence in which they were created.

If the region you defined as background has a higher average intensity value than your data object, you obtain a negative value for your adjusted volume in the analysis table. If this happens, select a new background region with less intensity than your data object.

**Relative Volume Quantity**

You can choose any one volume as a reference volume by selecting the Reference Volume checkbox in the Volume Properties dialog box. The reference volume is indicated by an asterisk on the volume label, for example, U1*.

Relative quantities are displayed in the Relative Quantity column in the analysis table (Volume Table tab). The relative quantity is the ratio of the background-adjusted volume divided by the background-adjusted reference volume.

All other volumes now display numerical values relative to your reference volume. Values higher than 1.00 indicate that the volume is greater than the reference volume. Values lower than 1.00 indicate the volume is less than the reference volume.

**Absolute Volume Quantity**

**Note:** Absolute volume quantity analysis is not available for multichannel images.

If you have drawn your volume around an object of known quantity, you can use it to calculate the quantity of your unknown volumes. The quantities of your unknown volumes are calculated based on the standard volumes and the selected regression method.

**To classify a particular volume as a standard**

1. Double-click the volume. This opens the Volume Properties dialog box.
2. Select the Standard option button and enter the quantity in the Quantity box.
3. Click OK to close the dialog box.

Standard volumes will have the default names S1, S2, and so on, based on the sequence of their creation.

**To review the regression curve**

- Open the Standard Curve window and select the Volume Standard Curve tab.

**Regression Methods**

Three regression methods are available to generate the volume quantification curve used for absolute quantity: linear, point-to-point, and cubic spline. To display the standard curve, click the Standard Curve button on the toolbar and select the Volume Standard Curve tab in the Standard Curve dialog box. See Regression Calculation Methods on page 253 to learn how each of these methods is calculated.

The data for volume standards are found in the Absolute Quantity column of the Volume Table.

**Note:** Selecting the Force Through Origin checkbox always starts the standard curve graph at 0,0, regardless of the best curve fit.

**Alignment**

Align volumes by using the appropriate alignment button. To select several volumes, Ctrl-click each one, then select one of the alignment buttons. Hover over any of the six alignment buttons to display its function (Align Left, Align Right, etc.)

Copy and paste selected volumes by pressing Ctrl+C to copy. Press Ctrl+V to paste.

When you click the Standard Curve button on the toolbar, a chart displays all unknown and standard quantities.
7 Generating Reports

After viewing results, you can generate a report that displays the analyzed gel images, all of the settings used in the protocol, and as much information about the data as you want to include.

You can choose print settings within the Report Settings dialog box in the Edit menu or by clicking Report in the main toolbar.

**Report**

**To produce a preview of your report**

- Click Report on the toolbar.

Use the following dialog boxes to customize the content in your reports. Doing so does not modify the data from the analysis.
Report Settings

Use this dialog box to customize the content of your report.

General Tab

The General tab includes the following settings:

- **Include Gel Image** — specify whether the image is included in the report. If the image is included, the following options determine which overlays are displayed on the gel image:
  - Show Lanes and Bands
  - Show Volumes
  - Show Annotations
  - Include Unannotated Image
When you select this checkbox, both the annotated image (if available) and unannotated images are printed in the report. The unannotated image precedes the annotated image in the report.

**Note:** If you disable the other checkboxes in the Include Gel Image group, the Include Unannotated Image checkbox is automatically disabled.

- **Image Info** — specify what information is included in the report.
  - Acquisition Information
  - Analysis Settings
  - Image Information
  - Notes

- **Signature History** — details on when and why a secure document was signed

  If a secure document has been signed, the user name, the date and time of the signature, and the reason for signing are all included in the Signature History section. If a document has not been signed, this section is omitted from the image report.
Lane and Band Table Tab

The Lane and Band Table tab includes the following settings:

- **Include Lane and Band Table** — specify whether to include the Lane and Band table in the report.

- **Lanes to show** — specify which lanes to display in the report.

- **Show Lane Profile** — specify whether to display the Lane Profile view.

- **Print one lane per page** — specify whether all lanes are printed on one page or whether each lane is printed on a separate page (adds a page break after each lane).

- **Show Lane Profile** — include the lane profile for each lane.

- **Not Displayed/Displayed** — remove columns that you do not want to display in the report. By default, the report displays all columns from the Lane and Bands table.
**Volume Table Tab**

The Volume Table tab includes the following settings:

- **Include Volume Table** — clear to exclude this information from your report.

- **Not Displayed/Displayed** — remove columns that you do not want to display in the report. By default, the report displays all columns from the Volume table.

**Print Report**

Click the Print Report button to print your report.

**Print Report to a PDF File**

The Print Report to .pdf File button opens a Save dialog box so the PDF file can be saved on your system.
Adjust the Printer Settings

The Printer Settings button accesses options for paper size, orientation, and page margins.
8 Exporting Results

The most convenient way to archive complete information about experiments is to produce reports. However, you might want to export only gel images or analysis table data for analysis in different programs, such as Quantity One®, FPQuest™, or InfoQuest™FP software. Or you might need exported files for presentation or publication.

Exporting Gel Images

Image Lab™ software includes features for exporting gel images several ways.

- You can export displayed image data to a publication (choose Export for Publication).
- You can export raw image data as a 16-bit .tif file (choose Export for Analysis).
- You can export image data to PulseNet. Doing so reduces the image to an 8-bit .tif file, limits its resolution, and restricts its file size to 300 Kb.
- You can export lane and band tables as well as volume tables to a spreadsheet program or to a file.
The options to export gel images are available using the Export option in the File Menu.

To export a displayed image to a file

- Select File > Export > Export for Publication.

Note: You can select from .bmp, .png, .jpg, and .tif formats. The gel displays with any lanes, bands, and annotations that appear on the screen. For a multichannel image, select the image pane you want to publish before exporting the image for publication. Image Lab software exports the active pane.
In this dialog box you can:

- Select the entire image or the current view
- Select the resolution or specify a custom resolution
- Specify the publishing dimensions
- View the resulting published image size and dimensions
You can zoom in on an area in a current view and export only that area, or you can export the entire image. You can exclude annotations or overlays by clicking Display Gel Options on the toolbar to access the appropriate settings.

![Display Gel Options](image)

### Exporting Gel Images for Analysis

**To export an image for analysis**

Select File > Export > Export for Analysis.

This exports the raw data only as a 16-bit .tif file.

**Note:** 16-bit .tif images are not compatible with all image viewers.

The image might require contrast adjustment when it is imported into analysis software. This option creates a file that can be analyzed in other programs such as Quantity One, FPQuest, or InfoQuestFP software.

**Note:** For multichannel images, Image Lab software exports the separate channel images, but not the multichannel image. Each exported channel image is saved with its application name appended to the filename you selected.
Exporting Gel Images to PulseNet International

To export an image to PulseNet International

- Select File > Export > Export for PulseNet.

Image Lab reduces the image to an 8-bit .tif image file. Resolution is limited and file size is restricted to 300 Kb.

**Note:** Export for PulseNet is not available for multichannel images.

Exporting Lane and Band Tables to Excel

If you have Excel (or Numbers on a Mac) installed on your computer, you can export the data to the spreadsheet application.

To export the data to Excel (or Numbers)

- Select File > Export > Lane and Band Table to Excel.

This opens a table directly in the spreadsheet program. You can then use the Save As option to produce other formats.

Exporting Volume Tables to File

To export an image as a CSV file

- Select Export > Volume Table to File.

Image Lab exports the image as a comma-separated values (CSV) file so the data file can be opened in a database application.

Screenshot Tool Export

Use the Screenshot tool, available on the toolbar, to capture a displayed image to the clipboard or to save it to a file (.bmp, .gif, .jpg, or .png).
Analysis Table Export

You can export table analysis data from the File menu or by using the export buttons at the top of the Analysis Table window.

The Analysis Table window has several buttons to export data to different formats, depending on how the data are to be presented.

Copy Analysis Table to the Clipboard
Copies the analysis table to the clipboard and then pastes the analysis table into word processing or presentation applications. It is best to use the vertical table orientation when copying to an 8.5 x 11-inch page to accommodate the columns.

Export Analysis Table to a File
Exports an analysis table as a CSV file, so your data file can be opened in a database application.

Export Analysis Table to a Spreadsheet
Enables you to use sort and formula functions of a spreadsheet program with your data. If you have Excel (or Numbers on a Mac) installed on your computer, the data open in the spreadsheet program.
9 System Calibration

When your imager is installed, instrument calibration is performed with a calibration wizard. See the installation guide in your Image Lab™ upgrade kit for detailed instructions.

The instrument calibration wizard performs several procedures required to automate the system and prevent focus problems. Each of these calibrations affects your system as follows:

- **Focus Calibration** — this calibration allows automated focus settings at any zoom point, using a (patent pending) software algorithm. Therefore, your focus remains correct whether you view an entire sample or an area of interest.

- **Focus Calibration with Height Offset** — this calibration takes the tallest of the available conversion screens into account, and extrapolates values for the others, so that focus remains optimal, for whichever screen is used.

- **Dark Reference Image** — this calibration determines and corrects any background signal present in your imager.

- **UV Flat Field Calibration** — this calibration generates the flat field correction profiles needed for the UV light source. Because of this calibration, your images have more accurate quantity reporting and backgrounds of even intensity.

- **Lens Flat Field Calibration** — this calibration corrects for the intensity roll-off inherent in any lens.

- **White Conversion Screen Calibration** — this calibration generates a flat field correction profile needed for the white light conversion screen.
Recalibrating Your Imager

When you add light sources or filters to a ChemiDoc™ MP imager, recalibrate your imager using the Instrument Setup dialog box.

To recalibrate your imager

1. In Image Lab, click Edit > Instrument Setup to open the Instrument Setup dialog box.
   - If you are adding a new light conversion screen (refer to UV/White Light Conversion Screen on page 236), select the appropriate box in the Illumination Options field.
   - If you are adding additional filters, select the appropriate box in the Filter Options field.
For any other changes to the optical pathway, perform a flat field calibration by clicking Reset in the Instrument Calibration > Flat Field panel and following the on screen instructions.

2. The software prompts you to restart the calibrations needed for the new illumination sources.

3. Click OK to exit the dialog box. Your settings persist until you make further changes.

**Note:** If the Gel Doc XR+ and ChemiDoc XRS+ systems are used to conduct quantitation with Bio-Rad's stain-free gel technology, Bio-Rad recommends performing the flat field calibration with the orange fluorescence reference plate (catalog # 170-8008) after installing Image Lab 5.1. For instructions on performing this calibration, see Calibrating the Imager to Use the Orange Fluorescence Reference Plate on page 242.
10 Image Lab Logs

Image Lab Logs

Image Lab™ software provides three types of logs.

- **Instrument log** — records events related to the instrument, including calibrating the instrument and the success or failure of the calibration. This log file is visible only if the computer running Image Lab is connected to an instrument.

- **System log** — records events related to running Image Lab, including enabling or disabling of secure mode and the users who log on to or log off of Image Lab.

- **Document log** — (Security Edition only) records events related to the creating and modifying of secure protocol and image files.
Viewing the Instrument Log

Instrument operations that you perform with Image Lab are recorded in the instrument log.

To open the Instrument Log Viewer

- From the View menu, click the log for your instrument.

The menu displays the specific instrument to which you are connected. The GS-900™ densitometer is shown as an example, above.

**Note:** You can view an instrument log only if Image Lab is connected to the specified instrument.

The instrument log includes the following information.

- date and time of the action
- the user name of the user logged into the computer at the time of the action
- the user’s security level
- the domain where the current user is logged in
- the type of action performed
- the result of the action taken, including complete records of the calibration
- the user’s reason for the action, if provided
Viewing the System Log

Events related to running Image Lab, including enabling or disabling of secure mode and users logging on to or logging off from Image Lab, are recorded in the system log.

To open the System Log Viewer

- From the View menu, click View System Log.
Viewing the Document Log

The View menu displays a list of logs for each open document. The document log captures information about creating and editing the Image Lab protocol and image files.

Note: Document logs are viewable only in Image Lab Security Edition, and only on Windows-based computers. Document logs are not viewable on the Mac.

The document log captures changes from:

- Image tools
- Lane and bands tools
- Normalization tools
- Molecular weight tools
- Quantity tools
- Volume tools

You can view the document log for any open file. This file can be a previously saved file, or it can be a newly created protocol or image file that is open on your desktop but which has not yet been saved.

If the document was previously saved, the log is identified with this name. If the document has not been saved, the log is identified with the time stamp, showing when the document was created.
To open the Document Log Viewer

- From the View menu, click the document log that you want to view. A typical document log is shown below.

Displaying Log Data

The display toolbar is located above the log.

Displaying Data Columns in Logs

By default, the logs display the following columns:

- Date and time
- User
- Level — the security role of the user
- Domain — domain where the current user is logged in
- Type — the type of event
- Description — the actual event captured
- Reason (For Secure Mode only) — the reason for signing a document

You can change your view of any log by displaying or hiding data columns.
To display or hide columns

1. From the View menu, open the log file.
2. Click the Display log viewer options icon.
3. In the Display Column Options dialog box, use the arrow keys to move columns between the Not Displayed and Displayed lists.

4. Click OK.

Filtering Data in Logs

For all Image Lab logs, you can filter the entries in the following columns:

- Date and time
- User
- Type

For example, you can set the filter in the Type column to File and Image Lab will display only the rows where Type is equal to File.
Setting filters in logs

To filter the entries of a column

1. In the log, click the heading of the column that you want to filter. The Display Filter options icon in the Actions tool bar is enabled. (By default, the log opens with all event types displayed.)

   **Note:** The Display Filter options icon is enabled only when you click on a column that can be filtered. The Display Filter options icon remains disabled if you click a column that cannot be filtered.

2. Click the Display Filter options icon to display the Select filter values dialog box.

   **Tip:** Alternatively, right-click the heading of a filterable column to display the Select filter values dialog box.

3. Select a value and click OK.

   **Tip:** You can select multiple values to filter.
Removing filters in logs

The Remove all filters icon is enabled only after you set a filter on a column. This icon clears all filters on all columns.

Each filterable column has a Remove filters icon as well. This icon removes the filter for that column only.

Collapsing or Expanding Data Rows

You can expand the size of rows in any log to display the full content of the row, or you can collapse the row size to display more rows in the table. The icon toggles between collapse and expand.
To display the full content of a row

- Click the Collapse or expand rows icon to expand the row height. The row adjusts to fit the text of the longest entry.

  This action expands all rows in the log where an entry is longer than the width of the column. Rows that do not need to wrap are not affected.

To display more rows in the table

- Click the Collapse or expand rows icon to collapse the row height to the default height setting.

  This action collapses all rows in the log to display data on a single line.

Exporting Logs

From the log viewer, you can:

- **Copy log entries to the clipboard** — copies the log entries to the clipboard, enabling you to paste them into a word processing or presentation application.

  **Tip:** You can also open a log in the log viewer and press Ctrl+C to copy the log entries to the clipboard.

- **Export log entries to a file** — exports the log entries as a CSV file that can be opened in a database application.

- **Export log entries to Excel** — exports the log entries to an Excel file where you can use Excel's sorting and formula functions to manipulate your data. If Excel is not installed on your computer, this feature is disabled.
To export a log file
1. From the View menu, click the log you want to view and export.
2. Click one of the icons to export the data in one of the supported formats.

Printing Logs
Log data can be sent to a printer or saved to a PDF file.

To print a log
1. From the View menu, click the log you want to view and print.
2. In the log viewer, click Print log.
The Log Print Preview window displays the contents of the log file.

From the Log Print Preview window, you can:

- Click Print log to print the log to a printer.
- Click Print log to PDF to save the log to a PDF file.
- Click Adjust printer settings to prepare the file for printing.
11 Using the Security Edition

21 CFR Part 11

Image Lab™ Security Edition is a module within the Bio-Rad Image Lab software that assists users in meeting the Food and Drug Administration’s regulations on good lab practices in the pharmaceutical and biotechnology industries. The Security Edition enables system administrators to ensure that Image Lab operates in compliance with Title 21 of the Code of Federal Regulations (CFR) Part 11 within a closed system. A closed system is defined as “an environment in which system access is controlled by the persons who are responsible for the content of electronic records that are on the system” (Section 11.3 (b) (4).

Note:
- Image Lab Security Edition is not supported by the Mac.
- The security controls built into Image Lab Security Edition must be properly configured and administered by the system administrator(s) in your organization in order to be secure and in compliance with 21 CFR Part 11.
- Bio-Rad makes no claim that Image Lab Security Edition software is CFR-compliant in and of itself, nor does the company guarantee compliance for the user. Your organization must establish policies and standard operating procedures that work in conjunction with the tools provided by Bio-Rad to ensure compliance with 21 CFR Part 11.
Standard Mode versus Secure Mode

Image Lab Security Edition can be run in either of the following modes:

- **Standard Mode** — in this mode, there are no restrictions on controlling the instrument, operating the software, or changing the documents.

- **Secure Mode** — in this mode, in addition to the features available in standard mode, extensive security features are enabled, including document signing and log creation.

When Image Lab is in secure mode, a padlock symbol appears in the left corner of the status bar. If no padlock is present, the software is running in standard mode.

When Image Lab is installed, by default it is set to run in standard mode. It continues to run in this mode until a user with Image Lab Administrator privileges enables secure mode.

This chapter assumes you are running the application in secure mode unless otherwise noted.

User Names, Groups, and Roles

When Image Lab Security Edition is run in secure mode, you must log in with a user name and password in order to run the application. The Microsoft Windows system administrator generally creates the user names and passwords. The Image Lab administrator defines the groups to which the Security Edition roles will be associated.

**Note:** See Setting Up Users and Groups on page 219 for additional information about setting up groups, user names, and passwords.
There are four default roles in Image Lab Security Edition. Each role is associated with one of the four default Image Lab user groups, and each user is assigned a role that provides the user access to specific features in the software. Table 10 lists the default Image Lab Security Edition user groups and the corresponding roles. It also provides a brief description of the permissions for each role.

**Note:** System administrators can change the user group names, if necessary, to meet their local company standards.

### Table 10. Image Lab Security Edition groups and roles

<table>
<thead>
<tr>
<th>User Group</th>
<th>Image Lab Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TDS_Administrator</td>
<td>Administrator</td>
<td>Users with this role can enable or disable secure mode. Administrator users can also view log files, but they do not have access to any other features.</td>
</tr>
<tr>
<td>TDS_User</td>
<td>Supervisor</td>
<td>Users with this role have full access to all features and functions of the application. They can also sign files. Supervisors cannot enable or disable secure mode.</td>
</tr>
<tr>
<td>TDS_Tech</td>
<td>Clinician</td>
<td>Users with this role can perform instrument operations, run existing protocols, and view protocol files, results files, and log files. They can also sign files. All other access is restricted. For example, they cannot create or edit protocols.</td>
</tr>
<tr>
<td>TDS_Guest</td>
<td>Reviewer</td>
<td>Users with this role can open and view protocol files, results files, and log files. They can also sign files. Users with this role cannot create new protocols and cannot change protocols. All other access is restricted.</td>
</tr>
</tbody>
</table>
Role Restrictions

Your role determines which features of the security edition you have permission to use. If you attempt to perform an action that is not permitted for a user in your role, you will see an error message. In some instances the user’s role determines which Security Edition features are visible and/or enabled. Therefore, you might not see all of the features described in this chapter.

Table 11 lists the Image Lab Security Edition functions that each role has permission to perform.

Table 11. User access to features by role

<table>
<thead>
<tr>
<th>Function</th>
<th>Administrator</th>
<th>Supervisor</th>
<th>Clinician</th>
<th>Reviewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/disable secure mode</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View log files</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Set up and recalibrate the instrument</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create new protocols</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open existing protocols</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Run protocols</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit protocols</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create new images</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open existing images</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Edit images</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analyze images</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sign documents</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>
Starting Image Lab Security Edition

When secure mode is enabled, you are prompted to log on when you start the Image Lab application.

To start Image Lab in secure mode

1. Click the Image Lab icon to start the application.

2. In the Log on to Image Lab dialog box, enter your user name and password.

3. Click OK.

Note: If you have any questions or problems logging on, see your system administrator.

Electronic Records

Image Lab Security Edition enables you to create secure electronic records as defined by 21 CFR Part 11. In Image Lab, the following are electronic records:

- Protocol files
- Image files
- Document log files
- Instrument log files
- System log files
Unsecured Documents

Protocol and image files created in standard mode or created with previous versions of Image Lab are unsigned, unsecure documents. Unsecure documents remain unsecure. When you open these files in secure mode, you can make changes to these files and save them without restrictions. A document log is generated for changes to these files, but the log is not viewable in standard mode. You must log in to secure mode to see the log.

You can also open unsecure documents in secure mode and sign them. You can make changes to these files and save them as secure documents. The original unsecure document remains unsigned and unsecure. The new document is saved as read-only with an incremental revision number and Image Lab generates an audit log. Image Lab will not be able to overwrite the secure file, but it can overwrite the original unsecure file.

Secure Documents

Protocol and image files created in secure mode are known as secure documents and generate a log. However, until they are signed, such documents save as standard files. Only after they are signed are they saved with the secure extension(.smptl, .smscn, .sptl, or .sscn). Image files generated from signed protocols automatically open the signing dialog box when the scan completes.

If you create a default protocol based on an existing signed protocol, the resulting new default protocol cannot be edited.

Note: A secure document can be saved unsigned. Likewise, a signed document can be saved as a new, unsigned file. In this case, the saved file is still a secure document. All changes to the document are captured in the document log.
Documents created in secure mode can be signed at any time. When a secure document is signed, it is saved as read-only. Image Lab cannot overwrite the document. You can open signed documents and sign them again. The newly signed file is saved as a second revision, and the new signatures are captured in the document log.

**Note:** Image Lab can never overwrite any signed file.

You can open secure documents in standard mode of Image Lab. Selecting Save As from the File menu creates an unsecure file. The original file is preserved. No log is generated for the new, unsecure document. However, an entry is added to the original log that the file has been reverted to unsecure.

**Secure Documents in SAM mode**

Images saved in signal accumulation mode (SAM) follow the same rules as the main image. The rules apply when the image is saved from within a protocol. If you create an image from a signed protocol, all resultant images must also be signed. If you try to save a file more than once, a warning message appears asking you to confirm the re-save. And if you confirm this re-save and click OK, Image Lab creates a new file with an incremental revision number.

**Modifying Secure Documents**

You can open and change a signed document in Image Lab. The original document is read-only and cannot be overwritten. Saving the revisions opens the Save As dialog box. The changes are saved into a new revision with an incremental revision number.

Each time a secure document is modified, you must provide a reason for each change before you can sign the document. The modifications are logged in the document log. The new signed document takes with it the entire history of the original document in its log.
Signing Documents

To sign a document

1. Select the protocol or results file.


3. Enter the user name and password of a user authorized to sign documents.

   **Note:** The user name and password can be for a user other than the current user.

4. Enter a reason for signing the document. Typical reasons include review, approval, responsibility, or authorship.

   **Note:** You must provide a reason in order to sign the document.

   The user name, date and time of the signature, and reason for signing are always included in the Signature History section of the image report (see page 177).

5. Click OK.

   A Save File dialog box appears.
6. Enter a new name for the file and click Save.

   **Note:** Signed protocols are saved with an .smptl extension, signed images are saved with an .smscn extension.

**Document Logs**

Any changes made or actions performed on a protocol or image file generate a document log documenting each change or action. This log is created as soon as the protocol or scan file is created. Protocols are updated when the protocol is saved or run. If you make changes to a file and save it as a new file, regardless of whether you are in secure mode, the document log is preserved in the new file. If you are in secure mode, the signature of the previous file is noted as part of the document log.

   **Note:** When a protocol is run, its log entries are copied to the resulting image file.

All major actions and changes are audited (generate a document log). Examples of auditable actions include:

- Signing a file
- Changing protocol settings
- Changing the image, for example, by cropping or rotating it
- Modifying the analysis, for example, changing the lanes and bands, or adding or editing annotation to the images

Minor changes that affect only the display are not audited, such as:

- Selecting different columns in the Analysis Table
- Changing the display options in Lane Profile
- Annotating or labeling the image using Annotation Tools

Each change you make to a signed protocol or image file must be documented in the Reason for Change dialog box.
Viewing the Document Log

The View menu displays a list of logs for each open document. The document log captures information about creating and editing Image Lab protocol and image files. You can view the document log for any open file. This file can be a previously saved file, or it can be a newly created protocol or image file that is open on your desktop but which has not yet been saved.

If the document was previously saved, the log is identified with this name. If the document has not been saved, the log is identified with the time stamp of when the document was created.

![Log file for Saved Image File](image1.png)

Log file for open but unsaved image file

The document log includes:

- Date and time
- User
- Level — the security role of the user
- Type — the type of event
- Description — the actual event captured
- Reason — the reason for signing a document

For more information about logs, see Chapter 10, Image Lab Logs on page 191.
A Maintenance

This chapter includes instructions for maintaining the universal hood in proper working condition by replacing parts.

UV Transilluminator Lamp and Starter Replacement

Note: The UV filter surface should always be kept clean from the chemical agents used as gel dyes. Use protective gloves when touching the UV transilluminator cover.

Depending on usage, the UV bulbs and starters last for many years. Replace bulbs when you notice them flickering. If a bulb does not turn on when it is new or moved, replace the bulb starter and test the bulb again.

Three types of bulbs are available. The catalog numbers are listed in Ordering Information on page 243. The standard bulb is 302 nm. Optionally, the 254 nm bulb is used for cross-linking of protein, and the 365 nm bulb is used to minimize denaturing of DNA.

To replace the lamps

1. Turn off the power.
2. Disconnect the power cord from the universal hood.
3. Remove the four screws located on the left/right sides of the transilluminator cover.
4. Remove the cover with the UV glass by sliding it forward, then lifting up.
5. Place it on a nonabrasive surface so that the glass does not get scratched or damaged.

**Note:** Do not put the UV cover directly on the bench. Wear gloves when touching the lamps.

6. Rotate the lamp until it becomes loose and the pins come to a vertical position.

7. Remove the lamp. Install the new lamp by rotating so that the pins are horizontal and the lamp is tight.

8. Remove the starter by rotating it counterclockwise, and then pull it out.

9. Insert a new starter into the holder and rotate clockwise.

10. Reassemble the cover and retighten the screws on both sides.
Fuse Replacement

Always unplug the instrument before changing or checking the fuses.

This unit is protected by two fuses (5 x 20 mm, 2 A Slo-Blo). The fuses are located in fuse holders housed in the power entry module. This module is located on the right side of the back of the universal hood.

To replace the fuses

1. Unplug the main power cable from the power outlet.
2. Use a flat screwdriver to turn the slotted front of each fuse holder counterclockwise; the holder pops out so you can extract the fuse.
3. Remove the blown fuses and replace them with two new fuses (catalog #900-8935).
4. Slide each fuse holder into the power entry module until it snaps in place.
## Troubleshooting

Follow these suggestions to troubleshoot your system.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera does not respond/camera not found</td>
<td>▪ Power to the camera may be turned off.</td>
<td>▪ Turn on the power to the camera.</td>
</tr>
<tr>
<td></td>
<td>▪ The camera cables may not be seated properly.</td>
<td>▪ Make sure that all cables are connected as shown in the Installation Guide.</td>
</tr>
<tr>
<td></td>
<td>▪ The software driver for the camera is missing.</td>
<td>▪ If the camera driver is not present, reload the camera driver from the Image Lab™ software CD.</td>
</tr>
<tr>
<td></td>
<td>▪ Computer power-saving modes may be interfering with the camera driver.</td>
<td>▪ Disable the power-saving modes on the computer.</td>
</tr>
<tr>
<td></td>
<td>▪ The cables may be defective.</td>
<td>▪ Replace the cables.</td>
</tr>
<tr>
<td></td>
<td>▪ The camera may be defective.</td>
<td>▪ Replace the camera.</td>
</tr>
<tr>
<td>Horizontal stripes in image when using the UV mode</td>
<td>▪ The emission filter may not be positioned properly.</td>
<td>▪ Move the filter lever so that the filter slider positions the filter under the camera lens.</td>
</tr>
<tr>
<td>Image is not visible on the monitor</td>
<td>▪ The monitor settings are incorrect.</td>
<td>▪ See your computer manual for the proper settings.</td>
</tr>
<tr>
<td></td>
<td>▪ The lens cap is attached.</td>
<td>▪ Remove the lens cap.</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Printout does not look like the monitor image</td>
<td>- The monitor settings are wrong.</td>
<td>- See your monitor manual for the appropriate settings.</td>
</tr>
<tr>
<td></td>
<td>- The printer settings are wrong.</td>
<td>- See your printer manual for the appropriate settings.</td>
</tr>
<tr>
<td>Light leakage into the darkroom</td>
<td>- The lens body is not seated properly against the gasket on the hood's adapter plate.</td>
<td>- Loosen the thumbscrew and seat the lens properly against the gasket on the hood's adapter plate.</td>
</tr>
<tr>
<td>Unable to focus on the sample using white light transilluminator or conversion screen</td>
<td>- Focus is not calibrated for samples using this light source.</td>
<td>- Select Edit &gt; Instrument Setup to recalibrate the focus for use with this accessory.</td>
</tr>
<tr>
<td>Lens limits seem artificially restricted</td>
<td>- The camera lens is not seated properly on the lens mounting plate.</td>
<td>- Re-seat the camera on the lens mounting plate.</td>
</tr>
</tbody>
</table>
C Setting Up Users and Groups

Setting Up Image Lab Users and Groups

This appendix explains how to set up users and groups to run Image Lab™ Security Edition software in secure mode.

Note: This task requires System Administrator privileges on the client computers (and possibly their domain) on which Image Lab is installed.

User Accounts

To give users access to Image Lab Security Edition, you can create new Windows user accounts, add existing user accounts to the four default user groups specified in Table 10 on page 205, or rename any of the four default user groups.

- A user account can have any name, but must have a password defined for the account. See the section on Password Security, on page 230 for information about setting passwords for maximum security.

- Each user can belong to the Image Lab Administrator group and one other Image Lab user group.

  For example, a user can belong to the Administrator group and the Supervisor group, but a user cannot belong to both the Clinician group and the Supervisor group.

User Authentication and Group Membership

Authentication in Image Lab is made up of two processes: user authentication and group membership evaluation.
User Authentication

In the user authentication process, Image Lab matches (authenticates) a user name with permissions assigned to that user name on the authentication domain. That domain can reside on your local computer (a local domain) or on a network server (a network domain). You set the location of this domain in the Domain to be used for authentication field of the Security Preferences dialog box. This name must be the exact name of your local computer or network server. For details on how to find this name see Finding the name of your authentication domain, on page 221.

In the Security Preferences dialog box, if you (or your network administrator) choose a local domain to be used for authentication, you are considered a local user. If you or your network administrator choose a network domain, you are considered a domain user.

Group Membership Evaluation

In the group membership evaluation process, Image Lab verifies that a user is a member of one or more of the four default Image Lab user groups (TDS_Administrator, TDS_User, TDS_Tech, or TDS_Guest). The valid members for each of these groups can be specified in one of two places, as defined by the Use local groups for establishing user security levels checkbox on the Security Preferences dialog box.
This checkbox specifies whether valid users and groups are defined on (1) the local Image Lab computer, or (2) on the network domain.

If this checkbox is selected, only users and groups that are defined on the local computer (on which Image Lab is installed) are recognized. If this checkbox is not selected, only users and groups that are defined on the network domain are recognized.

**Finding the name of your authentication domain**

Your authentication domain can be hosted on your local computer (a local domain) or on a network server (a network domain).

**To find the name of your local domain**

1. From your Start menu, open the Control Panel.
2. Click System.

The System window appears. In the Computer name, domain, and workgroup settings section, the name of your local computer is shown as Computer name.
To find the name of your network domain

1. From your Start menu, open the Control Panel.
2. Click System.

The System window appears. In the Computer name, domain, and workgroup settings section, the name of your network domain is shown as Domain.

<table>
<thead>
<tr>
<th>Computer name, domain, and workgroup settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer name: LSG07002297</td>
</tr>
<tr>
<td>Full computer name: LSG07002297.GlobalBio-Rad.com</td>
</tr>
<tr>
<td>Computer description: Image 1.2</td>
</tr>
<tr>
<td>Domain: GlobalBio-Rad.com</td>
</tr>
</tbody>
</table>

Configuring Users and Groups on a Local Computer

To set up users and groups on a local computer

1. In the Windows Control Panel, select Administrative Tools.
2. Select Computer Management.
3. In the Computer Management window, expand the System Tools folder, and then expand the Local Users and Groups folder.
To create a new user on a local computer

1. Click on the Users folder to open it and select Action > New User. Alternatively, use the right-click context menu.

The New User dialog box appears.

2. Fill out all the fields:
   - **User name** — the user name must be unique.
   - **Full name** — the full name must be unique.
     Bio-Rad recommends using the user’s actual full name, as this name will be shown in the document log and all the log reports. This is a requirement of 21 CFR 11.50a.
   - **Description** — this field must also be filled out.
     Bio-Rad recommends entering the user’s title as the description.
   - **Password** — enter and confirm a password for the user.
     **Tip:** Select the User must change password at next logon checkbox. This prevents the Windows system administrator from knowing the passwords of the users.
     **Note:** If you select the User must change password at next logon checkbox, the user must actually log on to Windows and change the

To create a new group on a local computer

1. In the Computer Management window, click on the Groups folder to open it and select Action > New Group. Alternatively, use the right-click context menu.

The New Group dialog box appears.

2. In the Group name field, enter the name of one of the groups specified in Table 10 on page 205 (TDS_Administrator, TDS_User, TDS_Tech, TDS_Guest). You can also enter a description in the Description field.

The group does not need any special operating-system level privileges.

3. Click Create to create and save the new group.

4. Repeat this task for the remaining groups specified in Table 10 on page 205.

To add a user to a group on a local computer

1. In the New Group dialog box, click Add. Alternatively, double-click an existing group in the Groups folder to open its Properties dialog box, and click Add.

You see the Select Users dialog box.
2. **Click Advanced to expand the dialog box.**

![Select Users dialog box](image)

3. In the expanded dialog box, click **Find Now** to populate the bottom field with all the users on the local computer.

4. Click a user name in the list to select it, or press the Ctrl key and click multiple users to select them.

5. When you have selected all the users to add to the group, click **OK**, and click **OK** again to close the Select Users dialog box.

6. Click **Create** to close the New Group dialog box and create the group.

   Alternatively, you can click **OK** to close the existing group’s Properties dialog box and accept the changes.
Configuring Users and Groups on a Network Domain

**Note:** The network administrator must know how users and groups are set up using the Windows server software at your site. The following example is used to illustrate the choices.

**To locate the users and groups on a Windows server**

- Open Administrative Tools and select Active Directory.

Note that in the Active Directory window, the Users folder lists groups as well.

**To create a new user on a Windows server**

1. With the Users folder open, select Action > New User. Alternatively, use the right-click context menu.

You see the New User dialog box.
2. Fill out all the fields:

- **User name** — The user name must be unique.
- **Full name** — The full name must be unique.
  Bio-Rad recommends using the user’s actual full name, as this name will be shown in the document log and all the log reports. This is a requirement of 21 CFR 11.50a.
- **Description** — This field must also be filled out.
  Bio-Rad recommends that you enter the user’s title as the description.
- **Password** — Enter and confirm a password for the user.
  **Tip:** Select the User must change password at next logon checkbox. This prevents the Windows system administrator from knowing the users’ passwords.
  **Note:** If you select the User must change password at next logon checkbox, the user must actually log on to Windows and change their password before using Image Lab Security Edition. Otherwise, Security Edition will not recognize the user.
To create a new group on a Windows server

1. With the Users folder open, select Action > New Group. Alternatively, you can use the right-click menu.

   You see the New Object - Group dialog box.

   ![New Object - Group dialog box]

2. In the Group name field, enter one of the group names specified in Table 10 on page 205 (TDS_Administrator, TDS_User, TDS_Tech, TDS_Guest).

   Type the name exactly as specified. You can also enter a description for the group in the Description field.

   **Note:** The group does not need to have any special operating-system level privileges.

To add a user to a group on a Windows server

1. In the New Group dialog box, click Add. Alternatively, double-click an existing group in the User Manager folder to open its Properties dialog box and click Add.

   You see the Select Users dialog box.
2. Click Advanced to expand the dialog box.

![Select Users dialog box]

3. In the expanded dialog box, click Find Now to populate the bottom field with all the users.

4. Click a user name in the list to select it, or press the Ctrl key and click multiple users to select them.

5. When you have selected all the users to add to the group, click OK, and click OK again to close the Select Users dialog box.

6. Click Create to close the New Group dialog box and create the group, or click OK to close the existing group’s Properties dialog box and accept the changes.
Password Security

21 CFR 11.300 (b) requires that passwords be “periodically checked, recalled, or revised.” Password policies are therefore recommended, although the password duration and rules are up to the system administrator and the organization. For instance, the exact duration between password changes is flexible.

To set password policies on a local computer

1. Open the Control Panel and select Administrative Tools > Local Security Policy.

2. In the left pane of the Local Security Policy window, expand Account Policies and then select Password Policy.

You see the password policies listed in the right pane of the window.
3. To change password policy settings:
   a. Right-click the policy and select Properties to open its properties dialog box.
   
   ![Minimum password age Properties dialog box]
   
   b. Modify the default setting to meet your company policy.
   c. Click Apply.
   d. Click OK to close the Properties dialog box.


**To set password policies in Active Directory**

1. Open the Control Panel and select Administrative Tools > Domain Controller Security Policy.


3. To change password policy settings:
   a. Right-click the policy and select Properties to open its properties dialog box.
   
   ![Minimum password age Properties dialog box]
   
   b. Modify the default setting to meet your company policy.
   c. Click Apply.
   d. Click OK to close the Properties dialog box.

Password Policy Setting Examples

The following examples are only suggestions. Your organization needs to establish its own password policy.

- Enforce password history: 12 passwords remembered
- Minimum password age: 5 days
- Maximum password age: 30 days
- Minimum password length: 8 characters
- Password must meet complexity requirements: Enabled
- Store passwords using reverse encryption: Enabled

Account Lockout Policy Setting Examples

- Account lockout duration: 0 (The account is locked out until the administrator unlocks it.)
- Account lockout threshold: 3 logon attempts
- Reset account lockout counter after: 30 minutes

Auditing Windows Event Logs

Some global auditing information is stored in the Windows Event logs. It is a requirement of 21 CFR Part 11 that these logs be archived. However, by default, Windows systems automatically remove these data without warning.

**Note:** It is therefore critical that the event log is reconfigured to generate and preserve all necessary log data. Regular manual intervention is also required to preserve these data.

**To open the Event Properties Log**

1. Open Administrative Tools and click Event Viewer.
2. Right-click on each log and select Properties.
3. In the section When maximum event log size is reached: select Do not overwrite events (Clear logs manually).

4. Increase the maximum size of the event log to cover any possible messages. The smaller the maximum size of the event log, the more often the system administrator must manually view, archive, and clear the system log.

Auditing information generated by the operating system is recorded in the Security Log. Logon failures in Image Lab Security Edition are recorded in this log.

During the review process, the log should be examined for attempted breaches of security, such as a series of failed logon attempts. To avoid the risk of losing data, the size should be very large and this inspection/archive process should occur daily. The Audit Policy should be set as follows:

- Audit account logon events — Failure should be checked at a minimum
- Audit account management — both Success and Failure should be checked
- Audit logon events — Failure should be checked at a minimum
- Audit policy change — both Success and Failure should be checked

**Miscellaneous Security Measures**

Bio-Rad recommends that you use the built-in protections that Windows Server offers in order to protect the computer while the user is absent.

**Note:** Microsoft is continually updating its operating systems in response to security issues. It is critical to keep all components of the Windows operating system, especially any domain controllers, up to date.
D Accessories

Calibrating Accessories

If you are installing accessories along with your original system installation, calibrate your system with a one-time Instrument Calibration wizard. Complete instructions are in the installation guide that arrives with your imager. If you acquire new conversion screens, light sources, or filters for a ChemiDoc™ MP imaging system after your original system installation, you will have to recalibrate your imager to use them.

See Chapter 9, System Calibration for instructions on how to calibrate newly acquired accessories.

Installing Optional Accessories

Epi Light Modules

Epi light modules are available for the ChemiDoc MP imager in three colors: red (catalog #170-8283), blue (catalog #170-8285), and green (catalog #170-8284). For installation instructions, see Installing an Epi Light, an instruction sheet that accompanies each module.
**UV/White Light Conversion Screen**

This optional white light conversion screen (catalog #170-8289) converts the UV light generated in the universal hood to white light. Your imager must be calibrated to use the white light conversion screen.

**To use the white light conversion screen**

1. Center the conversion screen on the imager stage.
2. Center your samples on top of the conversion screen.
3. Image the gel using your preferred application.
XcitaBlue™ Conversion Screen

The optional XcitaBlue conversion screen kit (catalog #170-8182) converts UV to blue light, which enables you to visualize DNA samples while protecting them against UV damage.

The XcitaBlue conversion screen is held in place by adhesive-backed edge guides. After the edge guides are installed, the conversion screen remains centered and will not slide, even if you close the drawer rapidly.
To install the XcitaBlue conversion screen

1. Perform a trial placement first, without removing the paper tape. Place the edge guides in each corner of your transilluminator, as shown. The edge guides should touch the inside of the drawer front and fit over the edge of the metal transilluminator border (shown in red).

2. Remove the paper tape from the bottom surface of each edge guide.

3. Press each edge guide into position carefully. After the adhesive surfaces touch, it is difficult to reposition the guide.

4. Calibrate your imager to use this accessory by going to Edit > Instrument Setup. Select the XcitaBlue Conversion Screen checkbox under Illumination Options. The software prompts you to calibrate the focus with height offset.

5. To visualize a sample using the XcitaBlue conversion screen, place the screen between the edge guides.

6. Center the gel on top of the XcitaBlue conversion screen, and proceed with normal image capture. Use the gel alignment template kit to center your gels easily and consistently.
Gel Alignment Template Kit

The Bio-Rad gel alignment template kit (catalog #170-8184) allows four sizes of standard agarose gels to be centered quickly and easily and ensures the consistent placement of each gel.

The kit contains:

- Magnetic locator frame
- Instruction sheet
- Alignment guides for the following gel trays:
  - Sub-Cell® GT UV-transparent mini-gel tray, 7 x 7 cm
  - Sub-Cell GT UV-transparent wide mini-gel tray, 15 x 7 cm
  - Sub-Cell GT UV-transparent mini-gel tray, 7 x 10 cm
  - Sub-Cell GT UV-transparent gel tray, 15 x 10 cm

The gel alignment templates fit exactly into the XcitaBlue conversion screen frame (catalog #170-8182).
To install and use the gel alignment template kit

1. Place the locator frame over the transilluminator with the magnetic side down. Match the corners of the magnetic locator frame with the edges of the transilluminator. The UV symbol on the frame will be in the same orientation as the UV symbol on the imager.

2. Place the gel alignment template that matches the size of your sample tray or agarose gel into the magnetic locator frame.

3. Place your gel or gel tray into the open area of the template.

Note: No recalibration is necessary to use the gel alignment template kit.

Orange Fluorescence Reference Plate

The orange fluorescence reference plate enables you to apply UV flat fielding corrections to your imager. Corrections are made for all UV illumination sources, filters, and the camera lens.

The orange fluorescence reference plate is recommended for quantitation with Bio-Rad’s stain-free gels, and can be used to correct for image nonuniformities for red and orange gels, including:

- Ethidium bromide
- GelRed
- Flamingo™
- Coomassie Fluor Orange
- SYPRO Ruby
- Krypton
- Qdot 625
The orange fluorescence reference plate (catalog #170-8008) can be used with several of the Bio-Rad® Molecular Imager® series of products, including:

- Gel Doc™ XR+ imaging system with Image Lab™ software
- ChemiDoc™ XRS+ imaging system with Image Lab software
- ChemiDoc XRS+ imaging system with Quantity One® software

When you order the reference plate, you receive:

- Orange fluorescence reference plate, overall dimensions: 29.5 x 29.5 cm; viewing surface: 27 x 27 cm
- Instruction sheet (10017296)
Calibrating the Imager to Use the Orange Fluorescence Reference Plate

Your imager must be calibrated to use the orange fluorescence reference plate.

To calibrate the imager to use the orange fluorescence reference plate

- Choose Edit > Instrument Setup and select the appropriate checkbox in the dialog box. Image Lab software guides you through the calibration.
### Ordering Information

The following table contains catalog numbers and descriptions for all parts available for the ChemiDoc MP imager, plus all optional accessories and replacement parts. For more information, see the Bio-Rad catalog.

<table>
<thead>
<tr>
<th>Catalog #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Molecular Imager Series of Products (includes Universal Hood III, Camera, Cables, and Accessories)</strong></td>
<td></td>
</tr>
<tr>
<td>170-8280</td>
<td>ChemiDoc MP imaging system</td>
</tr>
<tr>
<td><strong>Installation Kits</strong></td>
<td></td>
</tr>
<tr>
<td>170-8282</td>
<td>ChemiDoc MP installation kit</td>
</tr>
<tr>
<td><strong>Universal Hood</strong></td>
<td></td>
</tr>
<tr>
<td>170-8281</td>
<td>Universal Hood III</td>
</tr>
<tr>
<td><strong>Imaging Cameras</strong></td>
<td></td>
</tr>
<tr>
<td>170-8255</td>
<td>ChemiDoc MP camera with motorized zoom lens</td>
</tr>
<tr>
<td><strong>Image Lab Software</strong></td>
<td></td>
</tr>
<tr>
<td>170-9690</td>
<td>Image Lab software, Windows/Mac</td>
</tr>
<tr>
<td><strong>Optional Accessories</strong></td>
<td></td>
</tr>
<tr>
<td>170-8001</td>
<td>UV/White light conversion screen (UV to white light)</td>
</tr>
<tr>
<td>170-8182</td>
<td>XcitaBlue (UV to blue light) conversion screen kit, without standard detection filter</td>
</tr>
<tr>
<td>170-8283</td>
<td>Kit, Red LED Module</td>
</tr>
<tr>
<td>170-8284</td>
<td>Kit, Green LED Module</td>
</tr>
<tr>
<td>170-8285</td>
<td>Kit, Blue LED Module</td>
</tr>
<tr>
<td>170-8183</td>
<td>XcitaBlue (UV to blue light) conversion screen kit, with standard detection filter</td>
</tr>
<tr>
<td>170-8008</td>
<td>Orange fluorescent reference plate</td>
</tr>
<tr>
<td>170-8089</td>
<td>Mitsubishi P93W Printer, 100/240 V, USB</td>
</tr>
<tr>
<td>170-3759</td>
<td>Bio-Rad fluorescent ruler</td>
</tr>
<tr>
<td>170-3760</td>
<td>Gel cutter ruler</td>
</tr>
<tr>
<td>170-8184</td>
<td>Gel alignment template kit</td>
</tr>
<tr>
<td><strong>Replacement Parts</strong></td>
<td></td>
</tr>
<tr>
<td>170-8026</td>
<td>Image Lab focus calibration target</td>
</tr>
<tr>
<td>170-8027</td>
<td>Image Lab flat fielding disc</td>
</tr>
<tr>
<td>170-8185</td>
<td>XcitaBlue viewing goggles</td>
</tr>
<tr>
<td>170-7581</td>
<td>Mitsubishi thermal printer paper, 4 rolls</td>
</tr>
<tr>
<td>170-7813</td>
<td>Sample holders for gels</td>
</tr>
</tbody>
</table>
### Table 12. Ordering information, continued

<table>
<thead>
<tr>
<th>Catalog #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>100-2784</td>
<td>UV transilluminator lid (includes UV filter glass)</td>
</tr>
<tr>
<td>1001-4106</td>
<td>Thumbscrew for camera</td>
</tr>
<tr>
<td>170-8081</td>
<td>Filter, standard emission, 62 mm</td>
</tr>
<tr>
<td>100-1370</td>
<td>UV bulb starter, quantity 3</td>
</tr>
<tr>
<td>930-2242</td>
<td>Multicolor target</td>
</tr>
<tr>
<td></td>
<td><strong>Lamps</strong></td>
</tr>
<tr>
<td>100-1361</td>
<td>UVB lamp, 302 nm (1 each)</td>
</tr>
<tr>
<td>170-8097</td>
<td>302 nm lamp kit, (6 lamps)</td>
</tr>
<tr>
<td>170-8098</td>
<td>254 nm lamp kit, (6 lamps)</td>
</tr>
<tr>
<td>170-6887</td>
<td>365 nm lamp kit, (6 lamps)</td>
</tr>
<tr>
<td></td>
<td><strong>Fuses</strong></td>
</tr>
<tr>
<td>900-8935</td>
<td>Fuse T 2 A, 250 V, quantity 10</td>
</tr>
<tr>
<td>900-0234</td>
<td>Fuse T 4 A, 250 V, quantity 10</td>
</tr>
<tr>
<td></td>
<td><strong>Universal Hood III</strong></td>
</tr>
<tr>
<td>100-2787</td>
<td>Universal Hood feet, quantity 4</td>
</tr>
<tr>
<td>170-8068</td>
<td>UV Shield for Universal Hood</td>
</tr>
<tr>
<td></td>
<td><strong>Connection Cables</strong></td>
</tr>
<tr>
<td>931-0071</td>
<td>Cable, USB, Type A to B, 10 ft</td>
</tr>
<tr>
<td>901-0064</td>
<td>Cable, USB, Type A to B, 6 ft</td>
</tr>
<tr>
<td></td>
<td><strong>Optional Analysis Software</strong></td>
</tr>
<tr>
<td>170-9600</td>
<td>Quantity One 1-D Analysis software</td>
</tr>
<tr>
<td>170-9300</td>
<td>FPQuest™ software</td>
</tr>
<tr>
<td>170-9310</td>
<td>InfoQuest™FP Basic Fingerprint software</td>
</tr>
<tr>
<td></td>
<td><strong>Protein Standards</strong></td>
</tr>
<tr>
<td>161-0363</td>
<td>Precision Plus Protein™ Unstained Standards, 1 ml</td>
</tr>
<tr>
<td>161-0373</td>
<td>Precision Plus Protein™ All Blue Standards, 500 pl</td>
</tr>
<tr>
<td>161-0374</td>
<td>Precision Plus Protein™ Dual Color Standards, 500 pl</td>
</tr>
<tr>
<td>161-0375</td>
<td>Precision Plus Protein™ Kaleidoscope™ Standards, 500 pl</td>
</tr>
<tr>
<td>161-0385</td>
<td>Precision Plus Protein™ WesternC™ pack, 50 applications</td>
</tr>
<tr>
<td>161-0318</td>
<td>Prestained SDS-PAGE standards, broad range, 500 pl</td>
</tr>
<tr>
<td>161-0317</td>
<td>Unstained SDS-PAGE standards, broad range, 200 pl</td>
</tr>
<tr>
<td></td>
<td><strong>Nucleic Acid Standards</strong></td>
</tr>
<tr>
<td>170-8351</td>
<td>EZ Load™ 20 base pairs molecular ruler</td>
</tr>
<tr>
<td>170-8352</td>
<td>EZ Load 100 base pairs molecular ruler</td>
</tr>
<tr>
<td>170-8353</td>
<td>EZ Load 100 base pairs PCR molecular ruler</td>
</tr>
</tbody>
</table>
### Table 12. Ordering information, continued

<table>
<thead>
<tr>
<th>Catalog #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>170-8354</td>
<td>EZ Load 500 base pairs molecular ruler</td>
</tr>
<tr>
<td>170-8355</td>
<td>EZ Load 1 kb molecular ruler</td>
</tr>
<tr>
<td>170-8205</td>
<td>2.5 kb molecular ruler</td>
</tr>
<tr>
<td>170-8200</td>
<td>AmpliSize® molecular ruler</td>
</tr>
<tr>
<td>170-8356</td>
<td>EZ Load precision molecular mass ruler (base pairs/ng of sample)</td>
</tr>
</tbody>
</table>

**Pulsed Field Standards and Markers**

<table>
<thead>
<tr>
<th>Catalog #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>170-3624</td>
<td>CHEF DNA size standard, 5 kb ladder</td>
</tr>
<tr>
<td>170-3707</td>
<td>CHEF DNA size standard, 8 - 48 kb</td>
</tr>
<tr>
<td>170-3635</td>
<td>CHEF DNA size standard, lambda ladder</td>
</tr>
<tr>
<td>170-3605</td>
<td>CHEF DNA size marker, 0.2 - 2.2 Mb</td>
</tr>
<tr>
<td>170-3667</td>
<td>CHEF DNA size marker, 1 - 3.1 Mb</td>
</tr>
<tr>
<td>170-3633</td>
<td>CHEF DNA size marker, 3.5 - 5.7 Mb</td>
</tr>
</tbody>
</table>
Using Bio-Rad’s Stain-Free Technology

Bio-Rad’s stain-free gels eliminate the time-consuming staining and destaining steps required by other protein detection methods. Stain-free gels include unique trihalo compounds that allow rapid fluorescent detection of proteins with the ChemiDoc™ MP imager without staining.

When using Image Lab™ software version 5.1 or higher, the ChemiDoc MP imager is stain-free enabled to image these gels:

- Criterion™ TGX Stain-Free™ precast gels
- Criterion Stain Free™ precast gels
- Mini-PROTEAN® TGX Stain-Free™ precast gels
- TGX Stain-Free™ FastCast™ acrylamide solutions for handcast gels

When trihalo compounds in the gels encounter tryptophan residues, a UV light–induced reaction produces fluorescence, which can be easily detected by the ChemiDoc MP imager within gels or on low fluorescence polyvinyl difluoride (PVDF) membranes. Activation of the trihalo compounds in the gels adds 58 Da moieties to available tryptophan residues and is required for protein visualization. Proteins that do not contain tryptophan residues cannot be detected using this technology. The sensitivity of stain-free gels is comparable to staining with Coomassie Brilliant Blue for proteins with a tryptophan content >1.5%; sensitivity superior to Coomassie staining is possible for proteins with a tryptophan content >3%.
The benefits of stain-free technology include:

- Elimination of staining and destaining steps for faster time to results
- No background variability within a gel or between gels (as is often seen with standard Coomassie staining)
- Elimination of the need for acetic acid and methanol in staining and destaining, which reduces organic waste
- Visualization of transferred or blotted proteins on low fluorescence PVDF membranes

**Stain-Free Workflow**

For detailed information about the Activate/image gels step, refer to Acquiring Images on page 67. For all other workflow steps, refer to the Criterion™ Precast Gels Instruction Manual and Application Guide (bulletin #4110001) or to the Mini-PROTEAN® Precast Gels Instruction Manual and Application Guide (bulletin #1658100).

```
                Prepare buffers
                   ↓
Prepares gels and assemble electrophoresis cell
                   ↓
Prepare and load samples
                   ↓
Perform electrophoresis
                   ↓
Activate/image gels
                   ↓
Analyze the separation
```
Electrophoresis with Stain-Free Gels

Stain-free gels are made and packaged without sodium dodecyl sulfate (SDS), allowing them to be used for both SDS and native polyacrylamide gel electrophoresis (PAGE) applications.

To perform electrophoresis with stain-free gels
1. Prepare the sample and running buffers.
2. Set up the electrophoresis cell.
3. Perform the run.

Imaging Gels

Use unstained standards with stain-free gels, as some prestained standards are not compatible with stain-free technology. To monitor electrophoresis, use a 1:1 mixture of unstained and prestained standards.

Setting up a protocol for stain-free gels is very similar to setting up protocols for other applications. Follow the instructions in Setting Up a New Protocol on page 71. Choose one of the following activation times based on your sample and the purpose of your experiment:

- **Gels used in blotting** — use 1 min activation for optimal results when performing western blotting followed by immunodetection.
- **Good sensitivity** — use 2.5 min activation when samples are abundant and when a fully optimized signal-to-noise ratio is not necessary.
- **Best sensitivity** — use 5.0 min activation for detection of proteins that are in low concentration and for the best quantification of the maximum number of bands. Because the reaction is near completion after 5 min, this method offers an optimal signal-to-noise ratio.

Note: If the gel has already been activated for 2.5 min, activating it for another 2.5 min might improve it. But activating an image for more than 5 min will not.
Imaging Blots

To blot stain-free gels, use standard blotting procedures as described in the instruction manual you are using. Use only PVDF membranes with low background fluorescence, as membranes other than low fluorescence PVDF can result in high background or low sensitivity with the ChemiDoc MP imager.

To assess transfer efficiency, be sure to activate and visualize the gel using the imager before transfer.
Mitsubishi P93/P95
Thermal Printer

Setting up a Thermal Printer on Windows

The printer driver is on the Image Lab™ software installation CD in the Misc folder.

To set up a thermal printer on a Windows system

1. Install the printer driver.
2. Open the printer section in Control Panel.
3. Click the thermal printer icon and select Printing Preferences.
4. Configure the correct paper size. Select 1280 x 1280 from the dropdown list.
5. Click OK to apply your changes.
Setting up a Thermal Printer on a Mac

The printer driver can be found on the Image Lab software installation CD in the Misc directory.

**To set up a thermal printer on a Mac system**

1. Install the printer driver.
2. Connect the printer to the computer.

**To configure the correct paper size**

1. Start Image Lab software.
2. Select File > Page Setup.

3. In the Settings dropdown list, select Page Attributes.
4. In the Format For dropdown list, select the Mitsubishi printer.
5. In the Paper Size dropdown list, select 1280 x 1280.
6. In the Settings dropdown list, select Save as Default.
7. Click OK to save the settings.
G Regression Calculation Methods

Each regression method calculates a standard curve. Some of the methods provide the formula for the standard curve. In this case, the molecular weight can be calculated by:

\[ x = \text{relative front of the band of interest} \]
\[ y = \text{molecular weight of the band of interest} \]

**Linear (semilog):** The linear equation is \[ y = a + bx \], where \( a \) is the intercept and \( b \) is the slope of the line.

**Note:** The linear equation is calculated on the log of the molecular weight values.

The \( R^2 \) value can be used to determine the overall quality of the linear fit. A linear regression with an \( R^2 \) value of >0.99 is considered a very good fit. The primary advantage of this method is that it is extremely simple. The primary disadvantage is that it will deliver incorrect results if the data are not very linear.

**Point-to-point (semilog):** No single equation is available for the point-to-point method. The slope of each segment of the curve between data points is calculated independently.

**Note:** The log of the molecular weight values is used to calculate the slope for each segment of the curve.

**Logistic:** The logistic-4PL equation is

\[
y = d + \frac{a - d}{1 + \left(\frac{x}{c}\right)^k}
\]
where:

\( x = \) mobility

\( y = \) molecular weight

\( a = \) estimated molecular weight at infinity

\( b = \) slope of the tangent at midpoint

\( c = \) midpoint

\( d = \) estimated molecular weight at zero mobility

Since the curve generated by the logistic-4PL regression method represents a perfectly shaped S, it might not fit the data very well in all cases.

**Cubic spline:** Cubic spline curves are smooth curves that go through every data point. The model is a cubic polynomial on each interval between data points. In some cases, a spline curve can work well as a standard curve for interpolation. However, because the curve is calculated individually for every pair of points, it does not correspond to any single equation.
# Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aspect ratio</td>
<td>The ratio of the width to the height of an image.</td>
</tr>
<tr>
<td>CCD</td>
<td>(Charge-coupled device) A light-sensitive silicon chip used as a photodetector in ChemiDoc™ MP and ChemiDoc XRS+ camera systems.</td>
</tr>
<tr>
<td>Colormaps</td>
<td>Different color representations of a gel image.</td>
</tr>
<tr>
<td>Electrophoresis</td>
<td>A technique for separating molecules based on the differential movement of charged particles through a matrix when subjected to an electric field.</td>
</tr>
<tr>
<td>Example precision</td>
<td>The number of decimal places chosen for displaying a measurement.</td>
</tr>
<tr>
<td>Flat fielding</td>
<td>An average intensity computation that compensates for nonuniformities generated by an instrument.</td>
</tr>
<tr>
<td>Histogram</td>
<td>A graphed representation of the brightness, or gray value, of an image.</td>
</tr>
<tr>
<td>Native charge density</td>
<td>The inherent electrical charge of a protein without the addition of SDS.</td>
</tr>
<tr>
<td>pl</td>
<td>Isoelectric point; the pH at which a protein molecule carries no net charge.</td>
</tr>
<tr>
<td>Rf</td>
<td>Relative front value of the band. In Image Lab™ software, Rf has a value between 0 and 1 and indicates the relative movement of the band from top to bottom.</td>
</tr>
<tr>
<td>Quantitative imaging</td>
<td>Determines the quantity of a protein’s components through analysis of the pixel values in a digital image of the sample.</td>
</tr>
<tr>
<td>UV-B</td>
<td>The range of ultraviolet light used by the system.</td>
</tr>
<tr>
<td>UV transilluminator</td>
<td>The part of the imager that transmits UV light through a sample.</td>
</tr>
</tbody>
</table>